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Legal Notes

Unauthorized reproduction of all or part of this guide is prohibited.

The information in this guide is subject to change for improvement without notice.

We cannot be held liable for any problems arising from the use of this product, regardless of the information herein.

Regarding Trademarks
• PCL is a registered trademark of Hewlett-Packard Company.
• Microsoft Windows is a registered trademark of Microsoft Corporation in the U.S. and/or other countries.
• PostScript is either a registered trademark or trademark of Adobe Systems Incorporated in the U.S. and/or other countries.
• TrueType is a registered trademark of Apple Computer Inc.
• All other brand and product names herein are registered trademarks or trademarks of their respective companies.

Examples of the operations given in this guide are for the Windows XP printing environment. Essentially the same operations 
are used for Windows 95/98/Me/2000 environments.

Models supported by the KX printer driver

The explanatory screens shown in this guide may differ from your printing system.

Copier/MFP KM- 1510
KM- 1530
KM- 1810
KM- 1815
KM- 1820 / FS- 1118MFP
KM- 2030
KM- 2530
KM- 2550
KM- 3035
KM- 3530
KM- 4030
KM- 4035

KM- 4230
KM- 4530
KM- 5035
KM- 5230
KM- 5530
KM- 6030
KM- 6230
KM- 6330
KM- 7530
KM- 8030
FS- 1118MFP
KM- C830
KM- C830D

KM- C850
KM- C850D
KM- C2630
KM- C2630

Printers FS- 600
FS- 680
FS- 800
FS- 820
FS- 920
FS- 1000
FS- 1000+
FS- 1010
FS- 1018MFP
FS- 1020D
FS- 1050
FS- 1200
FS- 1700
FS- 1700+
FS- 1714M
FS- 1750

FS- 1800
FS- 1800+
FS- 1900
FS- 1920
FS- 3700
FS- 3700+
FS- 3718M
FS- 3750
FS- 3800
FS- 3820N
FS- 3830N
FS- 5800C
FS- 5900C
FS- 6020
FS- 6026
FS- 6300

FS- 6350TW 
FS- 6700
FS- 6750
FS- 6900
FS- 6950TW 
FS- 7000
FS- 7000+
FS- 7028M
FS- 8000C
FS- 9000
FS- 9100DN
FS- 9120DN
FS- 9500DN
FS- 9520DN
FS- C5016N
FS- C5020

FS- C8008N
FS- C8026N
Ci1100
DP- 1400
DP- 1800
DP- 2800
DP- 2800+
DP- 3600
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Chapter 1  Installation

Installing the Printer Driver in Windows
A printer driver is an application that sends documents to the printer. Install the printer driver 
from the supplied Kyocera Software Library CD-ROM. Once installed, a variety of printer 
settings can be configured. 

When installing the printer driver, specify the connection method to the computer. 
There are four connection methods:
• Local Connection
• USB Connection
• Network Connection
• LPR Connection

Local Connection
This section describes how to install the printer driver when the printer and computer are 
connected through a parallel cable connection.

To install using a Local Connection:

1 Ensure the power for the computer and printer are turned off. 
2 Connect the computer and printer using a parallel cable. Once connected, power on both 

devices.

NOTE

In Windows XP or 2000, you must be logged into the system with administrator 
privileges to install the printer driver.

NOTE

Once the printer driver is installed, you can add more components. For detailed 
information on installing components, see Installing Components on page 25.
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3 Insert the Kyocera Software Library CD-ROM into the CD drive.
Once the installation program launches, the License Agreement appears. 

4 Click View License Agreement to display and read the License Agreement. 
5 Click Accept to proceed to the Main Menu dialog box.

If the installation program fails to launch after inserting the CD-ROM into the CD drive, 
navigate to Windows Explorer, access the CD-ROM, and double-click the Setup.exe file.

NOTE

• Ensure the printer is ready to print (remove packing materials, insert paper 
and any toner or ink cartridges) before connecting the cable.

• For further details on connecting using a parallel cable, refer to the printer's 
Operation Guide.

• If the Welcome to the Found New Hardware Wizard dialog box is 
displayed, click Cancel.
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6 Click Install KX Driver.

7 The Welcome to the Kyocera Printer Installation Wizard dialog box appears. Click Next. 

8 The Local or Network Connection dialog box appears. Select Local connection, and 
click Next. 
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9 The Select Printer Model dialog box appears. From the list, select the Manufacturer and 
corresponding Printers you wish to connect, and click Next.

• If the Found New Hardware dialog box appears, click Cancel.
• If the Hardware Installation warning dialog box appears, click Continue Anyway.

• If the Network Printer Port Monitor dialog box appears, select Yes to install an e-mail 
printer port for network printing and click Next.
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10 The Select the Printer Port dialog box appears. Select LPT1: from Use the following
port:, and then click Next.

11 The Name Your Printer dialog box appears. 
Select Yes or No to use the printer as the default printer for Windows-based programs. 
Click Next. 

12 The Printer Sharing dialog box appears. 
If you do not want to share the printer, select Do not share this printer and click Next.
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13 The Print Test Page dialog box appears. 
• Select Yes (recommended) to print a test page to confirm the proper operation of your 

printer and click Next. If the test page does not print properly, click Troubleshoot to 
determine the problem.

• Select No if you do not wish to print a test page and click Next.

14 The Confirm Settings dialog box appears. Verify the settings and click Install. 
The printer driver installation begins.

15 Once the installation is complete, the Printer Installed Successfully dialog box appears. 
• Select Yes (recommended) to install optional components and click Next. Proceed to 

Installing Components on page 25.
• Select No if you do not wish to install optional components and click Next.
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16 Choose from one of the following options:
• Select Yes and click Next to install additional printer drivers. 

The New Printer Installation dialog box appears.
• Select No to complete the installation and click Finish.

The installation of the printer is now complete. If prompted, restart your system.

USB Connection
This section describes how to install the printer driver when the printer and computer are 
connected using a USB connection.

To install using a USB Connection:

1 Ensure the power for the computer and printer are turned off.
2 Connect the computer and printer using a USB cable. Once connected, power on both 

devices.

3 Insert the Kyocera Software Library CD-ROM into the CD drive.

NOTE

• Ensure the printer is ready to print (remove packing materials, insert paper 
and any toner or ink cartridges) before connecting the cable.

• For further details on connecting using a USB cable, refer to the printer's 
Operation Guide.

• If the Welcome to the Found New Hardware Wizard dialog box appears, 
click Cancel.



8

4 Once the installation program launches, the License Agreement dialog box appears. Click 
View License Agreement to display and read the License Agreement.

5 Click Accept to proceed to the Main Menu dialog box.

6 Click Install KX Driver.

7 The Welcome to the Kyocera Printer Installation Wizard dialog box appears. Click Next.

NOTE

If the installation program fails to launch after inserting the CD-ROM into the CD 
drive, navigate to Windows Explorer, access the CD-ROM, and double-click the 
Setup.exe file.
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8 The Local or Network Connection dialog box appears. Select Local Connection and 
click Next.

9 The Select Printer Model dialog box appears. From the list, select the Manufacturer and 
corresponding Printers you wish to connect, and click Next.

NOTE

• If Found New Hardware dialog box appears, click Cancel. 
• If the Hardware Installation warning dialog box appears, click Continue 

Anyway.
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• If the Network Printer Port Monitor dialog box appears, select Yes and then click 
Next.

10 The Select the Printer Port dialog box appears. Select USB port 
(for example, USB001 or KMUSB001) from the listed ports, then click Next and proceed 
to step 14. 
If there are no USB ports listed under Use the following port, proceed to step 11.
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11 Select KM USB Port: from the Create a new port type list, then click Next.

12 The KM USB Port monitor dialog box appears. Confirm the Port name and click 
Advanced... .

13 The Serial number list appears. Confirm the serial number and click OK.
If the Serial number list is blank, cancel the installation procedure. Turn off the printer and 
return to step 1.

14 The Name Your Printer dialog box appears. 
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Select Yes or No to determine whether to use the printer as the default printer for 
Windows-based programs. Click Next.

15 The Printer Sharing dialog box appears. Choose from one of the following options.
• Select Do not share this printer to limit the user access to this printer and click Next.
• Select Share as to share this printer and enter a share name. Click Next.

16 The Print Test Page dialog box appears. Choose from one of the following options.
• Select Yes (recommended) to print a test page to confirm the proper operation of your 

printer and click Next. If the test page does not print properly, click Troubleshoot to 
determine the problem.

• Select No if you do not wish to print a test page, and click Next.
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17 The Confirm Settings dialog box appears. Verify the printer settings and click Install. The 
printer driver installation begins.

18 Once the installation is complete, the Printer Installed Successfully dialog box appears. 
Choose from one of the following options.
• Select Yes (recommended) to install optional components and click Next. Proceed to 

Installing Components on page 25.
• Select No if you do not wish to install optional components and click Next.

19 The Printer Installed Successfully dialog box appears. Choose from one of the following 
options.
• Select Yes and click Next to install additional printer drivers. 

The New Printer Installation dialog box appears.
• Select No to complete the installation and click Finish.
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The installation of the printer is now complete. If prompted, restart your system.

Network Connection
This section describes how to install the printer driver when connecting to a network printer.

To install using a Network Connection:

1 Ensure the computer and printer are turned off.
2 Connect to the computer and printer using a network cable. Once connected, turn on both 

devices.

• If the Welcome to the Found New Hardware Wizard dialog box displays, click 
Cancel.

3 Insert the Kyocera Software Library CD-ROM into the CD drive.
Once the installation program launches, the License Agreement dialog box displays.

NOTE

For further details on connections using other network protocols, consult the 
configuration guide supplied with your network interface card.

NOTE

The KPrint utility must be installed in order to connect to a network printer. For 
further details, refer to the supplied Kyocera Software Library CD-ROM.

NOTE

• Ensure the printer is ready to print (remove packing materials, insert paper 
and any toner or ink cartridges) before connecting the cable.

• For further details on connecting using a parallel cable, refer to the printer's 
Operation Guide.

NOTE

If the installation program fails to launch after inserting the CD-ROM into the CD 
drive, navigate to Windows Explorer, access the CD-ROM, and double-click the 
Setup.exe file.
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4 Click View License Agreement to display and read the License Agreement.

5 Click Accept to proceed to the Main Menu dialog box.
6 Click Install KX Driver.

7 The Welcome to the Kyocera Printer Installation Wizard dialog box appears. Click Next.
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8 The Local or Network Connection dialog box appears. Select Network Connection and 
click Next.

9 The Locate Your Printer dialog box appears. Select one of the following search methods:
• Type the printer name...: Leave the printer name blank and click Next. All printers 

available on network servers appear. 
If you have directly typed in the print server name, click Next.

• Connect to a printer on the Internet or...: Search by URL for printers that operate 
with the Internet print protocol.
Find and select the printer URL and click Next.
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10 The Default Printer dialog box appears. Select Yes or No to determine whether to apply 
the selected printer as the default printer for all Windows-based applications. 

11 The Confirm Settings dialog box appears. Verify the printer settings and click Install. The 
printer driver installation begins. 

12 Once the installation is complete, the Printer Installed Successfully dialog box appears.
• Select Yes (recommended) to install optional components and click Next. Proceed to 

Installing Components on page 25.
• Select No if you do not wish to install optional components and click Next.
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13 The Printer Installed Successfully dialog box displays. Choose from one of the following 
options.
• Select Yes to install additional printers and then click Next. The New Printer 

Installation dialog box appears.
• Select No to complete the installation, and click Finish.

The installation of the printer is now complete. If prompted, restart your system.

LPR Connection
When the printer has a built-in network interface, you can print over a network using an LPR 
port. This section describes how to install the printer driver when the computer and printer are 
connected using a LPR port connection.

To install using an LPR Port Connection:

1 Ensure both the computer and printer are turned off.
2 Connect to the computer and printer using a network cable. Once connected, power on both 

devices.

3 Insert the Kyocera Software Library CD-ROM into the CD drive.

NOTE

• Ensure the printer is ready to print (remove packing materials, insert paper 
and any toner or ink cartridges) before connecting the cable.

• For further details on connecting using a network cable, refer to the printer's 
Operation Guide.

• If the Welcome to the Found New Hardware Wizard dialog box appears, 
click Cancel.
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4 Once the installation program launches, the License Agreement dialog box displays. Click 
View License Agreement to display and read the License Agreement.

5 Click Accept to proceed to the Main Menu dialog box.

6 Click Install KX Driver.

7 The Welcome to the Kyocera Printer Installation Wizard dialog box appears. Click Next.

NOTE

If the installation program fails to launch after inserting the CD-ROM into the CD 
drive, navigate to Windows Explorer, access the CD-ROM, and double-click the 
Setup.exe file.
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8 The Local or Network Connection dialog box appears. Select Local Connection and 
click Next.

9 The Select Printer Model dialog box appears. From the list, select the Manufacturer and 
corresponding Printers you wish to connect, and click Next.

NOTE

For further details on connecting a network printing environment, refer to the IB-
21E/IB-22 User's Manual on the CD-ROM supplied with your printer.

NOTE

• If Found New Hardware dialog box appears, click Cancel.
• If the Hardware Installation warning dialog box appears, click Continue 

Anyway.
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• If the Network Printer Port Monitor dialog box appears, select Yes and click Next.

10 The Select the Printer Port dialog box appears. Select KPrint Port: from the Create a 
new port: Type list, and then click Next.

11 The KPrint Add Port Wizard dialog box appears. Select Print using LPR (Line Printer 
Remote) and click Next.
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12 In the Enter the IP address or host name of the print server dialog box, enter the IP 
Address or Host Name and click Next.
• Click Search... if the IP Address or Host Name is not known. A list of available 

network printers displays. Select the network printer, then click OK. Click Next to 
continue.

13 Confirm the destination printer port name and click Next.

14 Confirm the settings, and click Finish.

15 The Name Your Printer dialog box appears. 

NOTE

If the KPrint utility is installed, the following procedure may differ.
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Select Yes or No to determine whether to use the printer as the default printer for 
Windows-based programs. Click Next.

16 The Printer Sharing dialog box appears. Choose from one of the following options.
• Select Do not share this printer to prevent other users from accessing this printer and 

click Next.
• Select Share as to share this printer and enter a share name. Click Next.

17 The Print Test Page dialog box appears. Choose from one of the following options.
• Select Yes (recommended) to print a test page to confirm the proper operation of your 

printer and click Next. If the test page does not print properly, click Troubleshoot to 
determine the problem.

• Select No if you do not wish to print a test page, and click Next.
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18 The Confirm Settings dialog box appears. Verify the printer settings and click Install. The 
printer driver installation begins.

19 Once the installation is complete, the Printer Installed Successfully dialog box appears. 
• Select Yes (recommended) to install optional components and click Next. Proceed to 

Installing Components on page 25.
• Select No if you do not wish to install optional components and click Next.

20 The Printer Installed Successfully dialog box. Choose from one of the following options.
• Select Yes and click Next to install additional printer drivers. 

The New Printer Installation dialog box appears.
• Select No to complete the installation and click Finish.

The installation of the printer is now complete. If prompted, restart your system.
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Installing Components
You can expand the functions of your printer driver by installing components that compliment 
the ways in which you utilize your printer. For more information on profiles, refer to Saving 
Profiles on page 125.

To install Printer Components:

1 Once the installation is complete, the Printer Installed Successfully dialog box appears.
Select Yes (recommended) and click Next.

NOTE

The displayed components may vary based on the printer model.
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2 The Select Components dialog box appears. Select the check box of the components you 
wish to install, and click Next. Follow the instructions in the dialog box to proceed. 

• The Confirm Settings dialog box appears. Verify the selected component items, and 
click Install.

3 The Printer Components Installation Completed dialog box appears. Choose from one of 
the following options.
• Select No to complete the installation, and click Finish.
• Select Yes to install additional printer drivers, and then click Next.

Refer to the Local and Network Connection dialog box shown in the previous section, 
to prepare for the installation of an additional printer driver. 

4 Continue the installation as describe above.Click Exit to complete the installation.
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The installation of the printer driver is now complete. If prompted, restart your system.

Installing the Latest Printer Driver
The latest Kyocera printer driver can be obtained from http://www.kyoceramita.com/
download/, and can be installed using the Windows Add Printer Wizard.

To install using the Add Printer Wizard

This section describes how to install a printer driver using the Add Printer Wizard.
1 Click Start in the Windows taskbar, and click Printers and Faxes to open the Printers 

and Faxes window. 

2 Click Add a printer in the Printer Tasks area on the left. The Add Printer Wizard dialog 
box appears.

NOTE

Windows 95/98/2000: Click Start in the Windows taskbar, click Settings-Printers 
in sequence to open the Printer dialog box. 
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3 The Welcome to the Add Printer Wizard dialog box appears. Click Next and follow the 
instructions. 

4 When the Completing the Add Printer Wizard dialog box appears, click Finish.

5 The Hardware Installation dialog box appears and the Hardware Installation warning 
message may display. If the warning message appears, click Continue Anyway.

Installation of the printer driver is now complete. If prompted, restart your system.

NOTE

The wizard can also be launched by clicking Add a printer in the File menu.
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Chapter 2  Printer Properties

This section explains how to customize the installed printer driver settings including:
• Accessing Printer Properties 
• Installing Optional Devices 
• User Settings 
• Page Description Language (PDL) Settings 
• Administrator Settings 
• Compatibility Settings 
Follow the steps below to set your preferred options as the default settings.These printer 
settings can be changed temporarily when printing from within other Windows-based 
applications.

Accessing Printer Properties
1 Click Start in the Windows taskbar, and click Printers and Faxes. The Printers and 

Faxes window appears. 
Windows 95/98/Me/2000: Open the Start menu, and click Settings and Printers in 
sequence to display the Print window.

2 Right-click on the printer icon in the Printers and Faxes window. A list appears.

3 Click Properties in the list. Properties dialog box appears.
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Installing Optional Devices
If you use optional devices such as a paper feeder, finisher or an additional hard disk, specify 
the device on the Device Settings tab of the device properties. You can also specify the 
memory setting, PDL (Page Description Language) settings for the user, administrator settings 
for front panel messages, passwords, and more.

To install optional devices:

1 Click the Device Settings tab.
2 In the Device Options of the Device Settings tab, select the check boxes for any optional 

devices installed in your printer.

NOTE

The printer pictured in the Printer Properties dialog box and the list of Device 
Options will vary depending on the printer you have.

NOTE

Some optional devices cannot be installed simultaneously. For example, a finisher 
and a booklet stitcher. After you have selected a device, other devices will be 
marked with a red X, preventing the selection of conflicting optional devices. 
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3 Select the check box of an optional device shown in blue, (such as the Finisher options), 
and a sub-dialog box appears with additional setting details. 

4 In the Memory box, select the memory capacity of your printer. This setting is required to 
optimize the downloading of printer fonts.

Punch Settings Select the check box for the finishing device the Device Options list, such as Finisher or 
Multi-Finisher. The Punch Unit Setting dialog box appears. Double-click the option to 
display the Punch Unit Setting dialog box if the device listing is already enabled. 
Select 2 Hole, 2 & 3 Hole, or 2 & 4 Hole punch option depending on the optional Punch Unit 
attached to your finisher to enable hole punching.

NOTE

• Double-click the option to open the sub-dialog box if a device listing is 
already enabled.

• The Hard Disk Settings dialog box appears if you select the Hard Disk 
option, enabling the configuration of virtual mailbox settings. For further 
details, see Assigning Virtual Mailboxes on page 32.
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Booklet Stitcher 
Punch Settings

The Booklet Stitcher feature allows you to set the number of holes punched in each printed 
page. If you enable the Booklet Stitcher check box in the Device Options list, the Punch Unit 
Setting dialog box appears. If the device listing is already enabled, double-click on it to 
display the Punch Unit Setting dialog box. 
Select the 2 Hole, 2 & 3 Hole, or 4 Hole option depending on the optional punch unit of your 
finisher to enable punching of the pages you print.

Assigning Virtual 
Mailboxes

If you enable the Hard Disk check box, the Hard Disk Settings dialog box appears and virtual 
mailboxes can be created. For further details, refer to Virtual Mailbox on page 113
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RAM Disk 
Settings

The RAM Disk functions as a hard disk saving print requests into the printer’s memory if a 
hard disk for printing is not installed. When a hard disk is installed, the RAM Disk function is 
inactive.

To change RAM Disk setting:

1 In the Device Options list, enable the RAM Disk check box. The memory capacity can be 
adjusted in the RAM Disk box. 

2 Specify the RAM Disk size. The maximum RAM Disk capacity may vary depending on 
your printer model and installed memory.

NOTE

The following functions can be used if a hard disk is installed: 
• Quick Copy
• Proof and Hold
• Private Print 
• Job Storage
• Temporary Storage
• Permanent Storage

NOTE

• Since the RAM Disk is volatile memory, all data sent to the printer is lost if 
the power is turned off. 

• The size of the RAM Disk is specified in settings on the printer operator 
panel. For further details, consult the printer’s Operation Guide.

NOTE

In the example of the FS-9500 shown above, if the memory corresponds to 32MB 
minus 8 MB, the maximum available capacity for the RAM Disk is 8 MB. The value 
in the RAM Disk box will not exceed 8 MB. For further details, consult the printer's 
Operation Guide.
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User Settings
The following user information can be configured by clicking User... on the Device Settings 
tab.
• Identification
• Unit of Measurement
• Language Preference Selection
• Simplified User Interface (printer FS-1018 only)

Identification You can display the user information for the current print job on the printer operator panel. For 
further details, refer to Job Name Display on page 39.
1 On the Device Settings tab, click User... .

2 The User Settings dialog box appears. In the User Name and Department fields, enter up 
to 31 characters.
• Enter the preferred name in User Name field. 
• Enter the group to which the user belongs in the Department field.

Unit of 
Measurement

The unit of measurement that you select here will be used in the following locations:
• Custom Paper Sizes setting in the Custom section on the Media tab
• Separation setting in the Position section on the Watermark tab
• Advanced Layout Settings on the Layout tab
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In the User Settings dialog box choose from inches or millimeters.

Language 
Preference 
Selection

The Language Preference option specifies the language of the driver tabs excluding General, 
Sharing, Ports, Advanced, Color Management, and Security. 
Select the Language Preference check box and select the preferred language from the 
Language Preferences list. To activate the new language, click OK in the User Settings and 
Properties dialog box.

Simplified User 
Interface

For printer FS-1018 only, the user has the option of selecting a simplified user interface for 
Printer Properties. 
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When this option is checked, Printer Properties appears in a simplified version when accessed 
from the Print dialog box of an application. The simplified user interface is shown below.

Page Description Language (PDL) Settings
You have the option to change the Page Description Language (PDL) by clicking PDL on the 
Device Settings tab. Depending on your printer model, available PDLs may vary. You can 
choose from PCL (Printer Control Language) XL, PCL 5e, PCL 5c, or KPDL. We recommend 
PCL XL. If you select one of the PDLs options, the selection appears in the lower corner of the 
3-D image.
If you receive a PDL printing error, select a different PDL and try again. 
1 On the Device Settings tab, click PDL... .
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2 The PDL Settings dialog box appears. Select select the desired languatge from the Page 
Description Language list. Refer to the table below for options and descriptions.

3 Settings... is available when the PDL is set to KPDL, and when PCL XL is selected on 
some models.

PCL XL

Options Descriptions
PCL XL 
(monochrome and color 
printers)

The most recent version of HP PCL and PCL 6. This PDL includes 
PCL 5e features.

PCL 5c 
(color printers)

Specifies HP PCL 5c as the PDL. 

PCL 5e 
(monochrome printers)

Specifies HP PCL 5e as the PDL. 

KPDL 
(color and monochrome 
printers)

Specifies KPDL, which is compatible with the Adobe PostScript 3 
language, as the PDL. KPDL is used when printing from 
applications that support PostScript 2 or 3. 
An optional KPDL upgrade kit may be required for some models. 
The GDI compatible mode can also be used.

NOTE

• In GDI compatible mode, vector graphics are rasterized for printing as 
bitmap images. Use the GDI compatible mode option to improve the graphic 
output quality created by the application.

• Due to memory restrictions, this feature is not available in certain printing 
environments.

Option Description
Disable Auto Media Type 
Switching

Disables the Media Type settings on the Media tab.
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KPDL

Administrator Settings
The following settings can be specified by clicking Administrator...  on the Device Settings 
tab. We recommend that the Administrator Settings should only be changed by the system 
administrator or authorized personnel.
• Job Accounting
• Job Name Display
• Setting the Administrator Password
4 To change the Administrator Password:

Job Accounting Job Accounting settings are specified by the system administrator to implement an accounting 
system for assessing charges or other budgetary applications. The accounting system can help 
manage or restrict the printing volume by department. For further details, contact your system 
administrator or authorized personnel. 

Options Descriptions
Allow Data Passthrough Reduces errors when printing complex jobs from applications that 

use the PostScript format.

Allow Native 
TrueType Download

Improves the print quality and speed when using TrueType fonts.

NOTE

The Administrator Settings dialog box appearance and options will vary 
depending on your printer. The range of settings is shown on the two versions of 
the Administrator Settings dialog box shown below.

NOTE

For further details, refer to Job Accounting in the Operation Manual on the 
supplied CD-ROM. This function is available on FS-6020 and later printer 
models. 
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Job Name 
Display

You can specify settings to display the job name, user name, or department for the current job 
on the printer's operator panel."
1 On the Device Settings tab, click Administrator... .

2 The Administrator Settings dialog box appears.
Select the Front Panel Message check box. Select the following options to display during 
a print job: 

3 Click OK. 

Setting the 
Administrator 
Password

By setting a password, you can protect and restrict the settings made in the Administrator 
Settings dialog box.

Options Description
Display Job Name Displays the job name during printing. The job name is the name sent from 

the application to the printer driver or it can be selected in the Job Settings 
dialog box before printing. 

Display User Name Displays the user name during printing. The user name is the information 
entered according to the instructions in Identification on page 34.

Display 
Department

Displays the user group during printing. The group name is the information 
entered according to the instructions in Identification on page 34.
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To set the Administrator password:

1 Select the Lock these Settings check box to access the Set Password dialog box.

2 In the Set Password dialog box, enter the new password in the New password field. 
Re-enter the password in the Confirm new password field and click OK. 

To change the Administrator Password:

1 On the Device Settings tab, click Administrator... .

NOTE

The password must be between 4 to 16 characters.
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2 The Enter Password dialog box appears. Enter the password and click OK.

3 The Administrator Settings dialog box appears. Clear the Lock these Settings check 
box. A Password message appears. 

4 Click OK. 

Refer to Setting the Administrator Password on page 39 to enter a new password.

Compatibility Settings
This feature allows you to change values for media sources, such as cassettes or the Multi-
Purpose Feeder, so that the Kyocera Extended Driver is compatible with previous drivers of 
other manufacturers or older Kyocera printers. This alignment of old and new media sources 
allows all macros created under previous drivers to maintain compatibility under the new 
Kyocera Extended Driver. 
You can use the Driver Info utility, available on the Kyocera Software Library CD, to compare 
the source values for all installed drivers. If the values for a given media source differ, reassign 
the value in the new driver to match the value in the previous driver.
Compatibility settings can be adjusted by clicking Compatibility... on the Device Settings tab.
Compatibility settings are specified when:
• printing from applications that save paper source information within documents
• the paper source settings are specified by your system environment.

Setting the Device Compatibility

1 On the Device Settings tab, click Compatibility... .

NOTE

Changing the device settings may result in printing errors. For further details on 
changing these settings, contact your nearest Kyocera dealer. 
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2 The Compatibility Settings dialog box appears. From the list in the Media Source 
Enumeration area, select the paper supply method.
The current value is listed in the Enumerated Value box. 

3 Enter the new value for the Enumerated Value and click Apply. You can also restore all the 
parameters to the default by clicking Reset.

4 Select the Disable Face-up Reverse Page Order check box to prevent Reverse Order 
Printing when output is face up.
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5 Select the Ignore Application Collation check box to bypass the Collate setting in the 
application, and give priority to the printer driver setting.

Auto Configuration
The Auto Configuration Tool lets users automatically configure the physical device settings of 
a printer through the Device Settings properties page if they are connected to the printer over a 
network. 
Auto Configure can detect printer devices such as input devices, output devices, RAM disk 
size, and hard disk size. Then it updates the Device Options list on the Device Settings 
properties page. Auto Configure keeps the printer driver’s Device settings consistent with the 
actual printer devices.
Auto Configure currently supports these ports for Windows operating systems:
• Windows 98 & ME – KPrint ports (Raw mode, LPR, and IPP) only
• Windows NT 4.0 – KPrint ports (Raw mode, LPR, and IPP) only
• Windows 2000 – TCP/IP Ports and KPrint Ports (Raw mode, LPR, and IPP)
• Windows XP – TCP/IP Ports only

1 Click Auto Configure.

NOTE

Click Printing Preferences on the General tab in the Properties dialog box to 
access collated printing options. 

NOTE

TCP/IP port can be either an IP address or the printer name (Host name). 
Windows 95 is not supported by KACT.
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An “in progress” message will appear.

The check box settings on the Device Options list will be changed and the 3D image will be 
updated according to the device options installed. Memory and RAM Disk information will 
also change based on the setting information returned. When completed, the following 
message will appear:

• The Auto Configure tool can not communicate with a printer if the printer is powered off or 
in the middle of booting up process. In such cases, Auto Configure will display the 
following message after the time out.

• The Auto Configure tool can not communicate with a printer through the Windows XP 
firewall. If this firewall is set to on for your machine, the following message appears:

You can change the settings in the Windows Firewall to allow communication between the 
printer and your computer. The default setting for Windows XP Service Pack 2 is for the 
Windows Firewall to be set to On. 
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1 When the Windows Security alert shown above appears, click Unblock to allow 
communication between the printer and your computer.

When you click Unblock, Auto Configure is added to the Windows Firewall exception list, as 
shown in the example below. The Windows Firewall is accessed through the Control Panel.



46



47

Chapter 3  Printing from Applications

This section describes the following printing tasks when printing from Microsoft Windows 
applications.
• Basic Printing Tasks
• Duplex Printing
• Reverse Order Printing
• Printing Watermarks
• Adjusting Image Settings
• Adjusting Color

Basic Printing Tasks
The steps required to print a document created with an application are explained below. You 
can select the printing paper size and output location.

Basic Printing

1 Insert the proper paper size (such as A4) into the printer's paper cassette.
2 From the application’s File menu, select Print. The Print dialog box appears.

NOTE

The Print dialog box does not look the same in every application. 
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3 Click Printer Name to open a list of installed printers. Select the desired printer. 

4 Specify the number of copies to print in the Number of copies field. You can print up to 
999 copies. When printing two or more copies, enable the Collate check box for collation.

NOTE

If Ignore Application Collation is selected in the Compatibility Settings dialog, 
the Print Collate setting will be disabled. See page 43 for setting information.

NOTE

When using Microsoft® Word®, we recommend that you click Options... and select 
Use printer settings for the default tray.
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5 Click OK.
6 Click Properties... to access the Properties dialog box.

7 On the Media tab, click the Page Size list and select the appropriate page size. 
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8 Choose either Portrait or Landscape to match the document page orientation. You can 
rotate the document 180 degrees by enabling the Rotated check box.

9 Click OK to return to the Print dialog box.

10 Click OK to start printing.

NOTE

• For best results when printing on transparencies or recycled paper (the back 
side of paper which has already been printed on), click the Media Type list 
and select the media type. For further details, refer to Matching the Paper 
Size before Printing on page 53.

• The printer automatically selects paper size that matches the size specified 
above. A message appears requesting you to fill the multi-purpose tray if the 
proper paper size is not available.

• Click the Source list to specify the paper cassette for printing.

NOTE

The Rotated setting is required when stapling the upper-right corner of the 
document. 
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Using a Different Print Size

This section describes how to print documents of different sizes than the original document. 
The document image is automatically adjusted to match the output page size.
1 In the Properties dialog box, click the Media tab.

2 In the Page Size list, select the original paper size. Click the Print Size drop-down list and 
select the preferred output paper size.

3 Confirm that the proper paper size is loaded. Click OK to return to the Print dialog box.
4 Click OK to start printing.

Printing Multiple Pages Per Sheet

You can print by arranging multiple pages of the source document on a single sheet of paper. 
When this function is enabled, the Scaling option is unavailable.
1 In the Properties dialog box, click the Layout tab.

NOTE

• The proportion of the source document page size is compared to the output 
paper size by using the Page Size feature. 

• Scaling allows you to select a percentage to increase or decrease the 
original image relative to the original page size. Refer to Scaling on page 
52.

• Select Same as Page Size in the Print Size list to restore the output page 
size.
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2 Specify the number of source pages in the Pages per Sheet list. You can select the 
horizontal direction for the page layout using Layout (Sequence). 

Scaling Based on the page and print size specified in the Print Size on the Media tab, you can reduce 
or enlarge the image from 20 to 500% before printing. However, only one page per sheet can 
be printed. 
1 Click the Layout tab in the Properties dialog box, and enter the scale percentage into the 

Scaling (20-500%) field, or adjust the value as needed.

NOTE

• If you select four pages per sheet, then four pages are printed on a single 
sheet as shown in the dialog box in the example above. If AUTO is selected 
as layout, pages are arranged from the top left corner to the bottom right 
corner.

• Enabling the Print Borders check box displays the page borders of each 
page.

• When KPDL is set for the PDL, printing may be affected in some 
applications. Change the setting to PCL XL or PCL 5e, or set Passthrough 
mode in the KPDL mode settings to Off. For further details on changing the 
PDL, refer to Page Description Language (PDL) Settings on page 36.
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2 If you click Advanced..., you can adjust the outside margins in a range from 
5.0 to 25.4 mm. 
• For outside margins to the left of the page, enter a number into the Left (Long Edge) - 

Width box. 
• For outside margins to the top of the page, enter a number into the Top (Short Edge) - 

Width box. 

• Select the Reduce Image to Fit check box if the printing data extends beyond the edge 
of the paper when setting a binding margin. The margins are reduced to match the page 
size adjustment. 

When you want to change the page size (for example, to enlarge an A4-size brochure for 
printing on A3 paper), refer to Using a Different Print Size on page 51. 

Matching the Paper Size before Printing

The printer automatically selects the paper size specified in the Page Size setting on the Media 
tab by default when you are printing on regular paper. However, the printer supports a wide 
variety of printing media depending on your printer model.
You can specify the media type in the Media Type setting for automatic paper source selection 
when using recycled paper, labels, or transparencies. You can also specify the finishing 
settings for best results. Automatic selection of paper sizes can be disabled in the PCL XL 
detail settings. For further details, refer to Page Description Language (PDL) Settings on page 
36.

1 Load the paper in a paper cassette or the multi-purpose tray.

2 Specify the media type in the print operator panel on the printer.

Left (Long Edge) Top (Short Edge)

Reduce Image 
to Fit 

NOTE

Labels, transparencies, and envelopes must be printed using the multi-purpose 
tray. Ensure the paper is properly loaded by following the instructions outlined in 
the supplied printer's Operation Guide.
When paper is loaded properly in the paper cassette, the printer can automatically 
detect the paper size. However, it is necessary to use the print operator panel on 
the printer to assign the media type of the paper cassette so that the printer can 
recognize it. The steps to specify the media settings are listed below.

NOTE

Use the multi-purpose tray in cassette mode (the default). For further details on 
multi-purpose tray modes, refer to the printer's Operation Guide.
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3 Access the printer Properties and click the Media tab.

4 Select the document paper size from the Page Size list.

5 From the Media Type list, select the type of media for printing, then click OK. 

6 Options available in the Media Type list are as follows.

Media Type Usable Paper Cassettes
Plain 64 to 90 g/m2 All

Transparency Multi-purpose tray (MP tray)
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Once printing begins, the printer automatically selects the paper to match the paper size and 
specified media type.

Printing on Paper of Non-Standard Sizes
The printer can print on custom sizes of paper by defining them as custom paper sizes. 

Follow these steps to save custom page sizes in the printer driver. 

1 Load the custom paper into the printer. For further details, refer to the printer's Operation 
Guide.

2 Click Start in the Windows taskbar to access the printer driver properties and then select 
the Printers and Faxes. The Printers and Faxes window appears.

3 Right-click the printer icon to access the Properties dialog box.
4 Click Printing Preferences to open the Printing Preferences dialog box. Click the Media 

tab.

Preprinted All

Labels Multi-purpose tray (MP tray)

Bond (securities) All

Recycled All

Vellum Less than 64 g/m2 All

Rough 90 to 200 g/m2 Multi-purpose tray (MP tray)

Letterhead All

Color 64 to 90 g/m2 All

Prepunched All

Envelopes Multi-purpose tray (MP tray)

Card Stock All

Thick Multi-purpose tray (MP tray)

High quality All

Custom (1-8) Refer to the next section.

Media Type Usable Paper Cassettes

NOTE

If the paper loaded does not match the size, type, or both, a message appears 
requesting you to load paper in the multi-purpose tray.

NOTE

For custom paper, supply the paper using the universal (adjustable) paper cassette 
or the multi-purpose tray. Custom paper sizes are not supported in the models 
listed below: 
FS-1700, FS-6300, FS-6700, FS-6700S, FS-6800, FS-7000, and FS-9000. 

NOTE

Windows 95/98/Me/2000: Access the printer driver properties by clicking Start in 
the Windows taskbar and then selecting the Printers window.
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5 Click Custom... . The Custom Paper Sizes dialog box appears.

6 Click Add... . The Add Paper Size dialog box appears. Enter a name for your custom paper 
size in the Name field. 

7 Enter the measurements in the Height and Width boxes in millimeters or inches. (Units are 
selected from the User dialog box of the Device Settings tab in the Properties dialog 
box.)

8 The following sizes are available for custom paper.

NOTE

The name can be up to 31 characters. 

Size Cassette MP tray Duplexer unit
Minimum (A4 printers) 148 × 210 mm

(5.8 x 8.3 inches)
70 × 148 mm (Portrait) 148 × 216 mm

Largest (A4 printers) 216 × 356 mm
(8.5 x 14 inches)

216 × 356 mm (Portrait) 216 × 356 mm

Minimum (A3 printers) 148 × 210 mm
(5.8 x 8.3 inches)

70 × 148 mm 148 × 210 mm

Largest (A3 printers) 297 × 450 mm
(11.7 x 17.7 inches)

310 × 458 mm 297 × 431.8 mm
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9 Click OK to save the page size and return to the Custom Paper Sizes dialog box. Confirm 
the name of paper size you just added.

10 Click OK.
Repeat the steps above if you want to add other custom paper sizes. A maximum of 20 
different paper sizes can be added.

Printing with Custom Paper Sizes

1 From the applications’s Printer Properties, access the Print dialog box. (Select Print from 
the File menu.)

2 On the Media tab, select the name of your saved paper size in the Page Size list.

Width = 150 mm

H
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Sample Paper Measurements (150 mm x 200 mm)
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3 Select the source cassette for the custom paper from the Source list.

4 Click OK to return to the Print dialog box.
5 Click OK to start printing. 

Duplex Printing
This section describes how to enable the duplex printing option. In order to activate this 
printing option, the duplex unit must be installed, and additional memory may be required 
depending on the printer model. For further details, refer to your printer's Operation Guide. For 
information on Booklet printing, see Booklet Printing on page 102. 
In the table below, the paper sizes and media types are not available for duplex printing:

Printing on Both Sides

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu and select Properties.)

2 Click the Layout tab. 

Paper size Media Type
A3 wide
A6
B6 
Postcards
Double postcards
Envelopes
Western size 2 (114 × 162 mm)
Western size 4 (105 × 235 mm)

Transparencies
Labels
Thin paper 
Envelopes 
Postcards
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3 Select the Print on Both Sides (Duplex) check box. Choose either Flip on Long Edge or 
Flip on Short Edge. 

4 Click OK to return to the Print dialog box.
5 Click OK to start printing. 

Manual Duplex Manual duplex enables printing on both sides of a sheet by ordering the print job so that after 
the first half of the print job has been printed, the job can be flipped over and fed from the 
cassette for the second side printing. Manual Duplex is not available when settings are made in 
the Advanced dialog box, accessed from the Media tab.
The steps for using Manual Duplex may vary, depending on your printer, what printer 
accessories you have installed, and what application you are printing from. 

Portrait

Landscape

Portrait

Landscape

Flip on Long Edge Flip on Short Edge
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The Print dialog boxes of some applications allow you to print just the odd or even pages so 
that you can use manual duplex, as shown in the two examples below. 

The Microsoft Word Print dialog box has a Manual Duplex checkbox, as show above. When 
this option is selected, the odd pages are printed and then a message (shown below) appears 
telling the user to flip the printed pages over and re-insert them in the input bin of the printer.

Some Kyocera printers have a manual duplex setting in Printer Preferences, on the Layout 
page. Instructions for using this method for manual duplex printing are below. If the 
Properties or Preferences dialog boxes for your printer don't have manual duplex settings, 
look for an option to print just odd or even pages in the Print dialog box of the application you 
want to print from, as shown above.”

Manual Duplex Settings
• The printer must be set to a local port. 
- OR - 
• The Source selection must be Cassette 1 or Cassette 2. 

Adobe Acrobat
Adobe Framemaker

Microsoft Word
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When using a network port, select Enable Manual Duplex on Network Port in the 
Compatibility Settings dialog box, accessed from the Device Settings tab. Manual Duplex 
cannot be used on a network port in Windows 9x.

To print on both sides, follow these steps:

1 In the Media tab, select Cassette 1.
2 In the Layout tab, select Print on Both Sides (Manual Duplex). 

3 Select Flip on Long Edge or Flip on Short Edge. 
4 Select Print Instructions to print an instruction sheet. Follow the printed instructions for 

placing the pages back into the cassette after the first side is printed. 
- OR -
Clear Print Instructions and follow steps 5-7.

5 Click OK in the Properties dialog and Print dialog. 
The even-numbered pages will be printed.
6 When printing stops, remove all printed sheets from the output tray. 

With Flip on Long Edge selected, turn the stack over on the long edge and put the pages 
into the cassette. 
With Flip on Short Edge selected, turn the stack over on the short edge and put the pages 
into the cassette. 

7 Click OK in the Manual Duplex Instruction dialog box. 
The odd-numbered pages will be printed.
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Reverse Order Printing
Prints document pages in reverse order, from the last page to the first. 
When heavy or other special papers are printed face up, the reverse order printing function 
places the order of pages into numerical order as shown below. 

Print pages in reverse order

1 Access the Properties dialog box and click the Output tab.
2 Select the Output tray from the Output to list. 
3 Select the Reverse Page Order check box in Finishing Options.

4 Click OK to return to the Print dialog box.
5 Click OK to start printing.

Prologue/Epilogue
The Prologue/Epilogue tab includes:

1
2

3

3
2

1

Disable Feature Clear the check box to enable the features in the Prologue/Epilogue 
tab. All files listed under Prologue/Epilogue Data Files will be applied 
to your print job, unless they are set to None (Unassigned). 
Select the check box to disable the features and files.

Prologue/Epilogue Data 
Files

From the list, select the desired Prologue/Epilogue data file. 
Commands are saved in text file (.txt) format. 

Add Click Add to browse for PRESCRIBE command files to add to the 
Prologue/Epilogue Data Files list. If the file is located on a network 
drive in a client/server environment, browse to the network path, for 
example: \\server name\folder name\file name.txt. 
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This command allows the user experienced in using macro commands to insert a macro into 
specific locations in the print job. An advanced user may choose to use this feature to embed a 
PRESCRIBE command that will call a macro to overlay PRESCRIBE form data or a graphic 
object, such as a logo or a signature, at a specific point in the print job. 

• This function embeds the PRESCRIBE command in the document. This allows execution 
of macros that contain settings such as printer emulation and foreign characters or overlays. 

• Insert Location specifies the location for burying the PRESCRIBE command, such as at 
the start or end of the document. 

Delete Select a file from the Prologue/Epilogue Data Files list and click 
Delete to remove it from the list.

Edit Select a file from the Prologue/Epilogue Data Files list and click Edit. 
The file will open in Notepad, where you can edit the text.

Insertion Point: Allows you to select the insertion point for embedded Prologue/
Epilogue data files. Choose one insertion point for each data file.

None [Unassigned] When multiple data files are listed in the Prologue/Epilogue Data 
Files list, you can set individual files to None [Unassigned] and they 
will be disabled.

Beginning of the Print Job Embeds a Prologue/Epilogue data file on the first page of a print job.

End of the Print Job Embeds a Prologue/Epilogue data file at the end of a print job.

Start of the Page Embeds Prologue/Epilogue data file to the start of each page 
for a print job. Select one page option:
• Only on Odd Pages applies an embedded Prologue/

Epilogue data file to all odd numbered pages. 
• Only on Even Pages applies an embedded Prologue/

Epilogue data file to all even numbered pages. 
• Pages applies an embedded Prologue/Epilogue data file to 

page numbers and/or page ranges. 

End of the Page Embeds Prologue/Epilogue data file to the end of each page 
of a print job. Select one page option:
• Only on Odd Pages applies an embedded Prologue/

Epilogue data file to all odd numbered pages. 
• Only on Even Pages applies an embedded Prologue/

Epilogue data file to all even numbered pages. 
Pages applies an embedded Prologue/Epilogue data file to page 
numbers and/or page ranges. 

NOTE

The options for Start of the Page and End of the Page are available only when PCL 
5e/c is selected as the Page Description Language in the Page Description 
Language dialog box. 
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Printing Watermarks
When printing using watermarks, your preferred text is printed in the document background. 
You can choose one of four standard watermarks or enter your own text.

Selecting the Watermark

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu and select Properties.)

2 Click the Watermark tab.
3 Clear the Disable Feature check box. 
4 Select from the Watermark Selection list. 

NOTE

The Watermark Selection list has four standard and customized watermarks. For 
further details on adding watermarks, refer to Adding Watermarks on page 65.
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Adding Watermarks

You can enter the text for a new watermark. The text font, color, size, and style can be 
adjusted.
1 From the application’s Print dialog box, access the Properties. (Select Print from the File 

menu and select Properties.)
2 Click the Watermark tab.
3 Clear the Disable Feature check box. 
4 Click Add... . The Watermark Properties dialog box appears. 

5 Click the Text Definition tab. 

Standard Watermarks
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6 Enter a name for your watermark in the Watermark Description field, and enter the text to 
be printed as a watermark in the Watermark Text field. 

7 In the Text Attributes section, specify the Font. Select a font from the Font list. 

8 In the Text Attributes area, specify the Color setting.
•  Monochrome printers: Select 10% Gray to 90% Gray or Black in the Color drop- 

down list. 
•  Color printers: Select from the Color list, or select Custom to choose additional colors.

9 In the Text Attributes area, specify the font Size. The font size is measured in points.
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10  In the Text Attributes area, specify the typeface Style. From the Style list, choose from 
regular, italic, bold, or bold and italic. 

11  Click OK.

Selecting and Creating Custom Colors (Color printers only)

In the Color setting, selecting the Custom option appears the standard Windows colors. In 
addition to the basic system colors, you can also create customized colors.
1 When you set the color in the Text Attributes, select Custom... from the Color list and 

click [...]. The Colors dialog box appears. 
(To use an existing color, click a color in the Basic colors area, and then click OK and skip 
ahead to step 7.) 

2  Click Define Custom Colors to open the color matrix and create a customized color. 
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3 On the color matrix, enter the numerical values for the hue, saturation, and luminosity 
levels. The created color appears in the Color/Solid box. 

• Hue and Saturation (Sat) Adjustment: 
Click and drag the pointer left/right or up/down to adjust the hue and saturation levels.

• Luminosity (Lum) Adjustment:
Click and drag the slider on the right of the color matrix to adjust the luminosity
   level.

4 Click Add to Custom Colors... to add your color to the custom colors. 
5 Click OK to save the custom colors. 
6 Click OK to return to the Watermark Properties dialog box.
7 Click OK.

Positioning Watermarks

1 In the Watermark Properties dialog box, click the Position tab.
2 Select Center on Page or User Defined to specify the text position.

• Center on Page: Places the watermark text in the center of the page.
• User Defined: Bases the watermark text position on the X and Y values for the 

horizontal and vertical coordinates.

Adjustment
Luminosity 

NOTE

Manual Adjustment: Select the Move option and hold the left mouse button while 
dragging the watermark image on the left to the desired position. 
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3 Specify the Text Angle. Click to select a preset Diagonal display (slanted to the upper 
right) or to select Angle, which allows you to enter your preferred angle (measured 
counterclockwise from 0 to 360 degrees).
•  Angle: Drag the slider horizontally or type the value. The angle of the text can be 

manually adjusted by placing the mouse pointer on the center or end of the text and 
dragging it to the desired position. 

4 Specify the Text Display. Adjust the number of watermarks printed and the amount of 
separation space between the text.
•  Enter the number of watermarks in the Count box, or drag the slider to adjust the 

value.
•  Enter the value for separation between watermarks in the Separation box in 

millimeters or inches in the User Settings dialog box on the Device Settings tab, or use 
the box to adjust the value. 

5 Click OK.

Deleting Watermark Text

1 Clear the Disable Feature check box on the Watermark tab. 

NOTE

• Manual Adjustment: You can select Rotate and hold the left mouse button 
while dragging the watermark image at left to the desired angle. 

• Select User Defined in the Text Position field and then Angle in the Text 
Angle. Activate the Select Rotation around Center of Text check box.
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2 From the Watermark Selection list, select the watermark text you wish to delete. Click 
Delete. 

3 Click OK to confirm the deletion. 

Editing Added Watermarks

Edit your own watermarks by following the steps below. When editing your added 
watermarks, you can change the watermark text, font, color, size, and style.
1 Clear the Disable Feature check box on the Watermark tab. 
2 From the Watermark Selection list, select the watermark text for editing.
3 Click Edit... . The Watermark Properties dialog box appears. 

Adjust the text position and other settings as desired. For further details, refer to Adding 
Watermarks on page 65, step 5 to 10 and Positioning Watermarks on page 68, step 1 to 3.
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Watermark Page Settings

1 In the Page Specification area, choose from All pages, First page only, All pages except 
first page, or Only on specified pages for printing the watermark text. 

2 Select the Print Onto Cover check box to select the cover page for printing the watermark. 

3 Click OK.

Adjusting Image Settings
The settings for Print Quality, Grayscale Adjustment and Font Settings are described below. 
Color printers also offer adjustment options in the Color Adjustment settings of the Color 
Adjustment dialog box.

NOTE

Enter the pages in the box to print the watermark on specific pages. For example, 
to print the watermark on pages 1, 3, 5, 6, 7, 8, 9, 10, 11, and 12, enter [1,3,5-12].

NOTE

Enable the Cover Mode option in the Advanced Media Settings on the Media tab 
to print the watermark text on the front or front and back covers. For further 
details, refer to Printing with Covers on page 93.

Color Printers

Monochrome Printers
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Print Quality You can specify the printer settings for Resolution and EcoPrint.

1 From the Print dialog box of the application, access the printer Properties.
2 In the Properties dialog box, click the Imaging tab.

3 Click to select the Print Quality from the Print Quality list.

Options Descriptions
Resolution The number of dots printed in one inch. Higher resolution allows more 

accurate printing of specific details.

EcoPrint Reduces the amount of toner placed on the printed page, extending the life 
of the toner cartridge, making it both economical and ecological. Because 
toner saturation is reduced, the entire image, text and graphics, appears 
lighter in the printed job. EcoPrint does not increase print speed.

Settings for Monochrome Printers

Print Quality Options Descriptions
High quality Prints using the highest printer resolution. 

Proof (monochrome 
printers only)

Prints using the second-highest level of resolution. 

Draft Prints at a resolution of 600 dpi.

Custom You can specify your preferred combination of settings for 
Resolution, Kyocera Image Refinement, and EcoPrint. For 
further details, refer to the instructions below.

NOTE

When you select Custom for the Print Quality, then click [...] next to the list, the 
Print Quality Settings dialog box appears. Refer to the following table to set the 
Resolution, Kyocera Image Refinement, and EcoPrint features.
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These options enable you to extend the use of your toner cartridges by adjusting the printing 
resolution. For color printers, these options are only available for monochrome printing.

Grayscale 
Adjustment

The Grayscale Adjustment setting is used for adjusting the brightness and contrast of 
graphics produced by monochrome printers. This setting is available on color printer models 
when the monochrome option is active. Text remains unchanged. 

To adjust grayscale settings:

1 Use the mouse to drag the slider horizontally toward (+) or (-) for Brightness and 
Contrast in the Grayscale Adjustment area. Alternatively, click the arrows at the right to 
increase or decrease the values in the boxes. 

Options Descriptions
Resolution (monochrome 
printers only)

Choose from 1200 dpi Fast mode, 600 dpi, or 300 dpi.
The printer models FS-1800, FS-1800+, and FS-3800 support 1200 
dpi Fine mode.

Kyocera Image 
Refinement

Smooths the outline of text and vector graphics. For color printers, 
this option is only available when printing in monochrome mode.

EcoPrint Depending on the model, choose from On, Off, 75%, or 50%. 

Grayscale Adjustment 
Options

Descriptions

Brightness Adjusts the brightness of graphics. The darkest setting is -100 and the 
brightest is +100. Choose 0 (zero) for a regular level of brightness. 
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Font 
Downloading

This setting specifies the method used to send TrueType fonts to the printer during printing.
1 Click Font Settings. The Font Settings dialog box appears. 
2 Select one of the three following methods for sending TrueType Fonts:

• Download TrueType fonts as outline
• Download TrueType fonts as bitmap
• Substitute with Device fonts

3 Click OK to save the Font Settings. 

Disable Device fonts

1 Even if you send the TrueType fonts to the printer as outline fonts or bitmap images, for 
common fonts, the printer substitutes fonts resident on the printer in certain cases.

Contrast Adjusts the contrast (the proportion of light to dark) of graphics. The 
faintest contrast setting is -100 and the strongest is +100. Choose 0 
(zero) for a regular level of contrast.

Grayscale Adjustment 
Options

Descriptions

True Type Font Options Descriptions
Download TrueType 
fonts as outline

Sends fonts to the printer system as outline fonts when using multiple 
fonts and font sizes. 
This option decreases the spooler size and can be combined with the 
Disable Device fonts. For further details, refer to the next item, 
Disable Device fonts.

Download TrueType 
fonts as bitmap

A small number of fonts and font sizes can be converted and sent to the 
printer as bitmaps. 
This option increases the spooler size and can be combined with the 
Disable Device fonts. For further details, refer to Disable Device 
fonts described below.

Substitute with Device 
fonts

Unsupported fonts are replaced with built-in fonts by the printer 
without altering the document. 
For further details, refer to the next item, Selecting Fonts for 
Substitution.
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2 In the Font Settings dialog box, enable the Disable Device fonts check box to prevent any 
substitution of TrueType fonts with built-in printer fonts. 

Selecting Fonts for Substitution  

1 Select your preference for substitution from the Available Device Fonts for each system 
font, and then click OK. 

Options Descriptions
Font Substitution... Determines the fonts that are substituted by the printer.

Substitute with 
Device fonts

Determines which printer fonts are used as substitutions. Select 
Substitute with Device fonts to activate Font Substitution.

Available Device 
Fonts

Displays the available fonts in the Font Substitution dialog box.
The fonts installed on your computer are listed in the System Fonts, and 
the printer fonts are listed in Available Device Fonts.
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Advanced Graphic Settings -- PCL

1 On the Imaging tab, click Graphics Settings.... The Graphics Settings dialog box 
appears. 

2 Determine the Options settings. Refer to the options and descriptions below.

3 Click OK to save the settings. 

Detailed Graphics Settings -- KPDL

1 Click Graphics Settings.... The Graphics Settings dialog box appears. 
2 Select the send method for images using the Optimization option.

Options Descriptions
Print Text as Black Prints color and gray characters in black. 

There is no effect on white text, color images, or graphics. 

Print Graphics as Black
(monochrome printers 
only)

Prints color graphics and text in black, without using grayscales. 
There is no effect on images or photographs using the following 
formats:
*.bmp: bitmap 
*.jpg:    joint photographic experts group
*.psd:   portable scheme debugger 
*.tiff:      tagged image file format
This function is enabled in Computer Aided Design (CAD) 
applications only. 

Mirror Print 
(Color Printers Only)

Prints a mirror image of the page, with right and left reversed. 
Produces a mirror-like effect. 
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3 Click the Optimization list and select Fast Printing or Document Portability. Refer to the 
options and descriptions below. 

4 Determine the Options settings. Refer to the options and descriptions below. 

5 Click OK to save your settings. 

Image Data Format 
Options

Descriptions

Fast Printing (Recommended) Delivers image data in binary format. You can 
reduce the amount of spooler data and raise printing speed. 

Document Portability Delivers image data in ASCII (7 bit) format.

Options Descriptions
Print Text as Black Prints color and gray characters in black. 

There is no effect on white text, color images, or graphics. 

Print Graphics as Black
(monochrome printers 
only)

Prints colored graphics or text in black, without using grayscales. 
There is no effect on images or photographs (*.bmp, *.jpg, *.psd, 
*.tiff). 
This function is enabled in CAD applications only. 

Reverse Image Outputs a reversed black and white negative effect.

Mirror Print Prints a mirror image of the page, with right and left reversed. 
Produces a mirror-like effect. 

Halftone Screen 
(monochrome printers 
only)

By disabling GDI compatible mode check box in the PDL 
Settings, you can enable the halftone screen settings. 
You can adjust the dithering process by changing the number of dot 
lines, angle, and dot shapes. 
Images are divided into dots. As the number of the dot lines increases 
and the interval between the dots grows smaller, the image is printed 
more distinctly. As the number is reduced and the interval between the 
dots is increased the image is printed more coarsely. For further 
details, refer to the next item, Half Tone Screen Settings on page 78.
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Half Tone Screen Settings

1 Click Halftone Screen... on the Graphics Settings dialog box. The Halftone Screen 
Settings dialog box appears. 

2 Clear the Use Printer’s Default Screens check box. 
3 Select from the list for each item, or enter values into the boxes to make settings. Refer to 

the options and descriptions listed below.

4 Click OK to save the settings. 

Adjusting Color
You can adjust attributes of text and graphics for your color printouts. 

Color Mode You can switch between printing in Color (CMYK) and Monochrome modes. Specifying 
Custom mode allows you to select the desired effects including Gray Component 
Replacement, Continuous Tone, Gloss Mode, and Monochrome. Refer to Color Mode 
Definitions table below.

To adjust color settings:

1 From the Print dialog box of the application, access the printer Properties. Select 
Properties in the Print dialog box opened from the File menu.

2 In the Properties dialog box, click the Color tab.

Options Descriptions
Ink Determines the color used for the printed output.

Frequency Set the number of lines and units for halftone dots. The units are lines/
cm or lines/inch. Enter a value in the Frequency box, and select the 
units from the list to the right. 

Angle Determines the halftone dot angle. The setting can range from 0.0 to 
180.0 degrees. 

Shape Set the dot shape for halftones. 
Choose from: Ellipse, Round, and Line.

Use Accurate Screens Fine adjusts the set values to ensure an accurate number of lines and 
halftone angle.
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3 Click the Color Mode list, and make a selection. For further details, refer to the table 
below. 

Color Mode Definitions 

If you specify Custom as the Color Mode in the proceeding step, you can make the Custom 
settings. Detailed settings are available for Gray Component Replacement, Continuous 
Tone, Gloss Mode, and Monochrome options and descriptions shown below. 
1 For the Color Mode, select Custom.
2 Click [...] next to Color Mode list to display the Color Mode Settings dialog box. 

Color Mode Settings 
Options

Descriptions

Color (CMYK) Uses the four toner colors to print text and graphics in full color.

Monochrome Uses only the black toner for black-and-white printing. 

Custom Opens the Color Mode Settings dialog box. You can adjust the 
settings for gray component replacement, continuous tone, glossy mode, 
and monochrome mode. For further details, refer to Color Mode 
Definitions.
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3 Select the check box for your preferred settings.

4 Click OK. 

Color Correction

Color Matching is used for greater consistency in color reproduction among various devices. It 
works by compensating for the different color spaces of color printers. A set of parameters 
called a profile is selected and applied. 
The KX printer driver offers a variety of profiles for each simulation of ICM, Monitor and Ink. 
Color matching options are described below. 
1 In the Properties dialog box, click the Color tab.

Color Mode Setting Item 
Options

Descriptions

Gray Component 
Replacement

Instead of deriving a black color by mixing CMY toners, the black 
toner is used. This conserves CMY toners and improves the quality of 
black printing. 

Continuous Tone Pixels are printed in multiple layers. This mode is best for printing 
photographs. 

Gloss Mode Enhances the luster of printing. Gloss Mode is not supported for 
duplex printing.

Monochrome Converts color data to grayscale for printing. This function can be 
used for a preview before printing in color mode. Gray Component 
Replacement and Continuos Tone cannot be used with the 
monochrome mode. 
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2 Select for your preferred settings.

ICM Settings

You can select an appropriate color reproduction method that agrees with the contents of the 
print data. 
1 Select ICM to display ICM Settings... .

Color Correction Options Descriptions
Automatic Color matching is performed based on default color settings. For 

details, refer to Color Reproduction Settings on page 82.

ICM 
(System Corrected)

Specifies how the color is processed in the print job in order to match 
the original as much as possible. Image Color Management (ICM) 
technology relies upon associating an output device like a printer 
with a Color Profile. An ICM Profile for a printer contains 
information about rendering accurate color information for that 
device. For further details about making these settings, refer to the 
next section, ICM Settings. 
ICM is available in Windows 2000/XP only. 

None 
(Application Corrected)

Color matching is only performed by the application.

Monitor Simulation 
(RGB)

Reproduces the colors in simulation with those displayed on the 
monitor in RGB mode. 
sRGB (HDTV): RGB color matching based on HDTV standards.

Ink Simulation
(CMYK)

Select Ink Simulation to display the list. Specifies color matching 
based on CMYK inks. This option requires that the PDL be set to 
KPDL. For further details, refer to Page Description Language 
(PDL) Settings on page 36. 
Euroscale Press: Simulation based on European offset printing 
standards. SWOP Press: Simulation based on American offset 
printing standards. 

Color Reproduction If Automatic is set for Color Correction, Color 
Reproduction settings can be made. Objects within the document 
being printed are separated into three types; images, text, and 
graphs. The Color Reproduction mode is matched for each. 
Reproduction can be closer to the original and more vivid than the 
colors displayed on the monitor. For further details about making 
these settings, refer to Color Reproduction Settings on page 82.
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2 Choose from the Rendering Intent options listed in the table below. 

3 Click OK to save the ICM Settings.

Color Reproduction Settings

Objects within the document being printed are separated into three types, images, text, and 
graphs, and the Color Reproduction mode is matched for each.
1 Select Automatic in the Color Correction area, then click Color Reproduction. 

ICM Setting Options Descriptions
Optimize for Exact Color 
(Colormetric)

Utilizes the same color is needed in all print jobs, such as business 
logos.

Optimize for Color Contrast 
(Best for Images)

Utilizes images or scanned photographs containing many colors 
or shades of color.

Optimize for Color 
Saturation (Best for Graphs)

Utilizes graphs or charts containing solid colors.

NOTE

To make this function effective, set the Color Profile as the default on the Color 
Management tab.
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2 The Color Reproduction dialog box appears. Select one of the items under Mode. Click 
OK to save the color reproduction settings. 

Color Adjustment Settings -- HSL

You can save the three Color Adjustment settings as a Custom selection. The setting options 
and saving instructions are described below.
1 From the Color Adjustment list, choose Custom 1, Custom 2, or Custom 3. 

Mode Options Descriptions
Auto 1 This is the most commonly used standard mode. 

Auto 2 • Text and graphs are printed in black. 
• Images are printed in colors close to those used in the 

monitor display.
• Text and graphics are printed in vivid colors. 

Auto 3 • Text and graphs are printed in black using four color toners 
(CMYK).

• Images are printed in colors close to those used in the 
monitor display.

• Text and graphics are printed in vivid colors. 
Auto 4 • Images and graphs are printed in colors close to those used in 

the monitor display.
• Text and graphics are printed in vivid colors. 

Picture Image Images, text, and graphs are printed in colors that are close to those shown 
on the monitor. This is the best mode for printing photographs. 

Text Print all objects written in black using black toner only. All objects are 
printed in vivid colors. 

Chart (Graphics) Print all objects, including those written in black, using four color toners 
(CMYK). All objects are printed in vivid colors. 
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2 Click [...] next to the list to display the Color Adjustment dialog box.

3 In the Color Space area, select HSL (Hue, Saturation, Lightness).

4 By clicking the buttons beneath the photograph, you can select from three different 
photographic images. 

Color Space Option Description
HSL (Hue, Saturation, and 
Lightness)

Offers adjustment of hue, color intensity, brightness, and contrast.
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5 Since the colors emphasized by each of the photographs are different, this simplifies the 
color adjustment process. 

6 Complete the Hue Adjustment. Adjust the distribution and balance of hues. 
• Coordinated Hue Adjustment: Select Master from the Hue Adjustment list. Drag the 

slider to the right or left to increase or decrease the value between 
-180 and +180.

• Specific Hue Adjustment: Select Red, Yellow, Green, Cyan, Blue, or Magenta from 
the Hue Adjustment list. Or drag the slider to the right or left to increase or decrease 
the values between -10 and +10. 

• Default settings: Click Reset to return to the original factory default settings. 

7 Adjust the Saturation and Lightness.
• Drag the slider to adjust the Saturation, Lightness, and Contrast, or increase or 

decrease the values between -10 and +10.
• Click Reset to return to the original factory default settings.

Saturation or RGB adjustment Skin tone and mid-tone 
adjustment

Hue adjustment
Crayons Portrait Fruit
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8 Click OK. 

9 Click OK to save the settings.

Color Adjustment Settings -- RGB

You can save the three Color Adjustment settings as Custom selections. The setting options 
and saving instructions are described below.
1 From the Color Adjustment list, choose Custom 1, Custom 2, or Custom 3.
2 Click [...] next to the list to display the Color Adjustment dialog box.
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3 In Color Space, select RGB mode.

4 By clicking the buttons beneath the photograph, you can select from three different 
photographic images. 

5 The color adjustment process is simplified since the colors emphasized by each of the 
photographs below varies. 

6 Adjust the RGB Level. 
• You can modify the levels of red, green, and blue based on the monitor settings. 
• Drag each slider of the RGB setting, or increase or decrease the values between -10 and 

+10 in the box.
• Click Reset to restore the original default settings.

Color Space Option Description
RGB Adjusts using red, green, and blue levels. 

Saturation or RGB Adjustment Skin tone and mid-tone 
Adjustment

Hue Adjustment
Crayons Portrait Fruit
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7 Click OK to save the color adjustment settings. 

8 Click OK.
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Chapter 4  Using Optional Equipment

This section describes useful functions of the printer driver.

Staple
The Staple feature is available on printers with an optional finisher installed. If a booklet 
stitcher unit is installed, the Booklet Printing feature is available. For further details, refer to 
Booklet Printing on page 102.
After installation, optional equipment must be selected by the printer driver (device settings). 
For further details, refer to Installing Optional Devices on page 30.
Printed documents can be stapled in the positions shown below.

Using the 
Stapler

NOTE

The properties boxes described here may differ from those for your printer. 

NOTE

Staple and Offset features cannot be used simultaneously. 

Upper Left Upper Right Booklet

NOTE

When the paper size is A4, B5, or Letter, the Orientation must be set to Rotated in 
order to staple the upper-right corner. For further details, see the explanation on 
page 50 in step 8 in the Basic Printing Tasks section. 
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To set stapler settings:

1 From the application’s Print dialog box, access Properties. (Select Print from the File 
menu and select Properties).

2 On the Output tab, select Finisher (Face-down) from the Output to list. 

3 Select the Staple check box in the Finishing Options area. Select one of the following as 
the stapling position: Upper Left, Upper Right, or Booklet. 

4 Click [...] on the right of the stapling position. The Staple Settings dialog box appears. 
Specify the number of pages to staple by adjusting the arrows in the Staple Count area. 
• All Sheets (maximum of 50): Staples and outputs all pages of documents that have 50 

pages or less. If the document being printed has 51 or more pages, it cannot be stapled. 
For example, If the document being printed has 58 pages, it cannot be stapled. 

• After every sheet(s): Parameter separates documents into sets with a specific number 
of pages, then staples and outputs them. You can designate from 2 to 50 pages in each 
stapled set. Even if there are fewer than the specified number of pages, the document 
will be stapled. For example, if stapling has been specified for every 50 pages and a 
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document is printed that has a total of 58 pages, the print job will be split into two 
separate stapled sets of 50 and 8 pages. 

5 Click OK to return to the Print dialog box, and click OK to start printing. 
6 The final printed document is stapled by the finisher and delivered to the output tray. For 

further details about stapler specifications, refer to your supplied finisher Operation Guide.

Offset
The Offset stacks each printed document by shifting from right to left as it is delivered to the 
output tray. 

Offset is available on printers with a supported finisher (optional) installed. 
After installation, optional equipment must be recognized by the printer driver (device 
settings). For further details, refer to Installing Optional Devices on page 30.

Using the Offset

1 From the application’s Print dialog box, specify the number of copies of the document to 
be printed. 

2 Click Properties in the Print dialog box. The Properties dialog box appears.
3 Click the Output tab in the Properties dialog box.

NOTE

Offset and Staple cannot be used simultaneously.

Output direction
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4 Set either Finisher (Face-down) or Finisher (Face-up) as the output destination, then 
enable the Offset check box in the Finishing Options section.

5 Click OK to return to the Print dialog box, and click OK to start printing. 
After the first set is delivered, the second set will be delivered offset to the side. Then the 
printer delivers the third set in the same position as the first and the fourth set in the same 
position as the second. 

Punch
The Punch feature inserts holes in each printed page.

The Punch feature is available on printers with supported optional finisher installed.
After installing the printer driver, optional equipment must be selected in the driver in order to 
use the punch option (device settings). For further details, refer to Installing Optional Devices 
on page 30.

Using the Punch

1 In the Properties dialog box, click the Output tab.
2 Select either Finisher (Face-down) or Finisher (Face-up) as Output destination.

NOTE

Punch and Booklet Printing cannot be used simultaneously.
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3 Select the Punch check box in the Finishing Options section, and select the number of 
holes.

4 Click OK to return to the Print dialog box, and click OK to begin printing. 
5 Holes are punched in each printed page.

Cover Mode, Page Insert, and Transparency Interleaving
This section describes the cover mode, page insert, and transparency interleaving features of 
the printer driver. When the Cover Mode, Page Insert, and Transparency Interleaving options 
are used with the multi-purpose tray, cassette mode (the default setting), must be set. For 
further details, refer to the print system's Operation Guide.
• Cover Mode: Adds a front or back cover to your document. 
• Page Insert: Inserts blank or printed pages before pages in your document. 
• Transparency Interleaving: Inserts a blank or printed page between each transparency.

Printing with 
Covers

For your document's front cover or front and back covers, you can insert and print on paper 
that is a different weight or color than the paper for the body of the document. You can also 
specify cover printing when completing booklet printing settings. The paper used for printing 
the document body is specified in the Media settings of the Properties dialog box. The source 
of the cover paper is specified by adjusting settings in the Advanced Media Settings dialog 
box. You can also print on the covers. 
A duplexer must be connected in order to print using the Front Inside or Back Outside. You 
must also specify Print on Both Sides (Duplex) on the Layout tab. 
Although the Cover Mode and Page Insert may be used simultaneously, they cannot be used 
with the Transparency Interleaving option.
For further details on printing with covers in the booklet printing settings, refer to Booklet 
Printing on page 102.
1 From the application’s Print dialog box, access the printer Properties. Select Print from 

the File menu and select Properties.
2 In the Properties dialog box, click the Media tab, and then click Advanced....
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3 Select the Cover Mode check box. Select your desired page arrangement as shown in the 
following table. 

Cover Printing 
Options

Check Box Selection Cover Insertion Type
Front • Inserts a blank front cover.

Front
Front Outside

• Prints on the outside surface of the front cover.

Front 
Front Inside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover.

Front 
cover

Front 
cover

Front 
cover
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Front 
Print Onto Front Outside
Print Onto Front Inside

Duplex Printing (page 50).

• Prints on the outside and inside surfaces of the front 
cover.

Front and Back • Inserts blank front and back covers.

Front and Back
Front Outside

• Prints on the outside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Inside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Outside
Front Inside

Duplex Printing (page 50).

• Prints on both sides of the front cover and inserts a 
blank back cover.

Check Box Selection Cover Insertion Type

Front 
cover

Front 
cover

Back
cover

Front 
cover

Back
cover

Front 
cover

Back 
cover

Front 
cover

Back 
cover
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Front and Back
Back Inside

• Inserts blank front and back covers.

Front and Back
Back Outside

Duplex Printing (page 50).

• Prints on the outside surface of the front cover and 
inserts a blank back cover.

Front and Back
Back Inside
Back Outside

Duplex Printing (page 50).

• Prints on the inside surface of the front cover and 
inserts a blank back cover.

Front and Back
Front Outside
Front Inside
Back Inside
Back Outside

Duplex Printing (page 50).

• Prints on both sides of the front cover and inserts a 
blank back cover.

Check Box Selection Cover Insertion Type

Front 
cover

Back 
cover

Back 
cover

Front 
cover

Front 
cover

Back 
cover

Back 
cover

Front 
cover
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To edit cover printing options:

1 From the Media for Cover list, select the media type or source cassette for the front and 
back covers. When you choose the media type, a source cassette matching that media is 
automatically selected. 

Heavy, thin, or other special papers must be supplied from the multi-purpose tray. 

2 Click OK to return to the Media dialog box.
3 Load the paper for the front and back cover in the paper cassette selected in step 1. 
4 Click OK to return to the Print dialog box
5 Click OK to start printing. 

Page Insert You can insert a preprinted page or a page of a different paper type before a designated page. 
You can also print on the inserted paper. If a duplex unit is installed, you can also print on the 
reverse of the inserted paper. 
Although the Page Insert and Cover mode may be used simultaneously, they cannot be 
combined with the Transparency Interleaving described in Transparency Interleaving on 
page 100.

Insert Page Printing

1 From the application’s Print dialog box, access the printer Properties. (Select Print from 
the File menu and select Properties).

NOTE

Media type selections are not supported for the following models: 
KM-1510, KM-1530, KM-1810, KM-4230, KM-5230, and KM-6230.
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2 In the Properties dialog box, click the Media tab, and then click Advanced....

3 Select the Page Insert check box. Select the check box corresponding to your desired page 
arrangement as shown in the following table. To print on both the front and back of the 
inserted page, enable the Print onto Front and Print onto Back check boxes.

Check Box Options Printing Inserted Pages Descriptions
Page Insert • Inserts a blank page before the second page.

Inserted 
page
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I

Combinations

To adjust media combination settings:

1 Enter the page number to insert. A page will be inserted between the page number you 
entered and the page before it. You can designate for pages to be inserted starting from 
page 2 and ending on page 255.

2 To designate several pages in the document for insertion, enter a comma (,) to separate 
them. For a series of insertions in a range of pages, use a hyphen (-). For example, to insert 
a page before pages 5, 11, 12, 13, and 18, enter [5,11-13,18].

3 From the Media for Page list, select the media type of the inserted page or the source paper 
cassette.

Page Insert
Print onto Front

• Prints on the outside surface of the inserted page.

Page Insert
Print onto Back

Duplex Printing (page 50).

• Prints on the inside surface of the inserted page.

Page Insert
Print onto Front
Print onto Back

Duplex Printing (page 50).

• Prints on both sides of the inserted page.

Check Box Options Printing Inserted Pages Descriptions

Inserted 
page

Inserted 
page

Inserted 
page
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4 When you choose the media type, a source cassette that matches that media is 
automatically selected. Heavy, thin, or other special papers must be supplied from the 
multi-purpose tray. 

5 Click OK to return to the Media dialog box. 
6 Click OK to return to the Print dialog box.
7 Load the paper for insertion in the paper cassette.
8 Click OK and begin printing. 

Transparency 
Interleaving

By inserting a page between each sheet of paper, you can avoid damaging the transparencies. 
This function is only available when printing transparencies supplied from the multi-purpose 
tray. On these inserted pages you can print the same content as for the transparencies.
Transparency interleaving and Cover Mode or Page Insert cannot be used simultaneously.

Transparency Interleaving Method

1 From the application’s Print dialog box, access the printer Properties. Select Print from 
the File menu and select Properties.

2 From the Source list on the Media tab, select Multi-Purpose Feeder.
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3 From the Media Type list, select Transparency.

4 Click Advanced... to access the Advanced Media Settings dialog box. 



102

5 Select the Transparency Interleaving check box. To print the transparency content on the 
inserted pages as well, Select the Print onto Backing check box.

6 From the Media for Backing list, select the media type and the source paper cassette. 
When you choose the media type, the source cassette where that media is loaded will be 
automatically selected.

7 Click OK to return to the Media dialog box. 
8 Click OK to return to the Print dialog box.
9 Load transparency into the multi-purpose tray.
10 Click OK and begin printing.

Booklet Printing
Using the Booklet Printing option, you can print a two-page layout on both sides of single 
sheet of paper, then bind it in the center. Booklet printing is available with printers equipped 
with duplexers. Stapling and binding requires optional document finishers. For further details 
on Staple settings, refer to Staple on page 89.
The supported paper sizes for Booklet Mode printing are A3, ledger, B4, A4, and letter size. 
The Booklet Printing can be combined with the Cover Mode. For further details, refer to 
Printing with Covers on page 93.
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Left-Edge and 
Right-Edge 
Binding

Printing a four-page document as a booklet, for example, will result in automatic duplex 
printing shown below. You can choose between left-edge binding and right-edge binding.

Using Booklet Printing

1 From the application’s Print dialog box, access the printer Properties. (Select Print from 
the File menu and select Properties.)

2 Access the printer Properties and click the Layout tab.
3 Select the Booklet Mode check box. Choose either Left Edge Binding or Right Edge 

Binding. 

4 Complete the following steps to utilize the stapling feature.

Left Edge Binding

Outside

Inside

Outside
Outside

Inside

Outside

Inside

Outside

Outside

Inside

Right Edge Binding
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5 Click the Output tab, and set Finisher (Face-down) for Output to.

6 Select the number of copies you wish to print.
7 Select the Staple check box. Booklet (Fold) printing is selected automatically. 

Click [...] to the right of the list and set the number of sheets to staple together. The 
maximum number of sheets that can be stapled with booklet mode is 10 (40 pages). When 
printing documents that have more than 40 pages, the pages over 40 will be separated and 
printed in groups of 40 each. 

8 Click OK to return to the Print dialog box.
9 Click OK to start printing. 

Collating Modes
By attaching a sorter to your printer, you can specify how printed documents are stacked in the 
output trays after printing.
The number of output trays and their receiving capacity (the number of sheets) varies 
depending on the sorter model, refer to your sorter's Operation Guide.
Frequently, the application settings are given priority, causing a change in the sorter output 
method depending on the application. Verify these settings before printing your documents.

Sorter Modes There are three sorter modes to choose from. These modes are selected on the printer driver 
Output tab: 
• Collating mode
• Non-collating mode
• Mailbox mode
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Sorter Mode 
Differences

Collating

1 Access the Properties and click the Output tab.

Collating • Collating produces the specified number of 
copies as complete sets of documents in 
each tray.

• The document is printed following the page 
order and received in each tray. The number 
of document copies must not exceed the 
number of trays. If a tray becomes full, the 
printer pauses and displays a message to 
remove the paper from the tray. After the 
paper is removed, printing resumes for the 
remaining number of copies.

• This function requires a hard disk installed 
in the printer or a RAM Disk. For setup 
information, refer to RAM Disk Settings on 
page 33.

Non-collating • Collating produces the specified number of 
copies but divides the document for output 
in each tray, with page 1 in tray 1, page 2 in 
tray 2, and so on. For example, printing 20 
copies of a four page document using 
grouping produces 20 copies of page 1 in 
tray 1, 20 copies of page 2 in tray 2, and so 
on.

• The number of document copies must not 
exceed the sheet capacity of any tray. If a 
tray becomes full, the printer pauses and 
displays a message to remove the paper 
from the tray. In addition, the maximum 
document page length must not exceed the 
number of sorter trays. If a tray becomes 
full, the printer pauses and displays a 
message to remove the paper from the tray.

Mailbox • The mailbox mode produces copies in 
specified user trays, which is useful when 
the printer is shared among different users. 
For example, specifying tray 5 produces a 
copy of the document in tray 5.

• If a tray becomes full, the printer pauses 
and displays a message to remove the paper 
from the tray.

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5

Page 1
Page 2 Page 2 Page 2

Page 1 Page 1

20 copies of 

20 copies of 

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5

Page 1
Page 1 Page 2

Page 2
Page 3

Page 3

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5
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2 From the Output to list, select Mailbox Face-down. 

3 Select the Collate check box.

4 Select the number of complete sets in the Copies box. When printing using the collate 
option, specify the number of copies not to exceed the number of trays. The document page 
length must not exceed the tray capacity (for example, 200 sheets).

5 Click OK to return to the Print dialog box, and click OK to begin printing. The specified 
number of copies are produced in separate trays.

Non-Collating Clearing the Collate check box produces page 1 in tray 1 and page 2 in tray 2.
1 Access the Properties and click the Output tab.
2 From the Output to list, select Mailbox Face-down.
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3 Clear the Collate check box. 

4 Click OK to return to the application’s Print dialog box and begin printing. The specified 
number of copies of each page of the document are delivered to each tray.

Mailbox Mode 1 From the Output to list, select Mailbox Face-down.
2 Select the Mailbox check box. Select the desired output tray to be used (for example 

Mailbox 1) from the list at right.

3 Click OK to return to the Print dialog box, and click OK to start printing. The document is 
delivered to the specified tray, (for example Mailbox 1).
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Rotate Collate
The Rotate Collate stacks the sets produced in the top tray in alternating orientations.

This function is available when printing using A4, B5, and letter size paper. During printing, 
the same size paper must be loaded into two separate paper cassettes. For example, Portrait 
(A4) and Landscape (A4-R) would be used when printing onto A4 paper. The MP tray can also 
be used as a paper source. 
This function requires a hard disk installed in the printer or a RAM Disk. For further details on 
Hard Disk settings, refer to RAM Disk Settings on page 33.

Using Rotate Collate

1 Access the Properties and click the Output tab.
2 From the Output to list, select Top Tray (Face-down).
3 Enter the number of sets to be output in the Copies box. The number of pages for all copies 

of the document being printed must not exceed the tray capacity.
4 Select the Collate and Rotate Collate check boxes.

5 Click OK to return to the Print dialog box, and click OK to start printing. The collated 
document sets are delivered in alternating horizontal and vertical orientation.

Job Settings
The Job Settings option is available when you install an optional hard disk or a RAM disk on 
the printer. For further details on hard disk installation and setup, refer to RAM Disk Settings 
on page 33. Private print and Proof and Hold can be used with a RAM Disk.
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Job Settings offers a variety of functions as listed below.

Quick Copy After using the quick copy feature, a document can be reprinted from the operator panel.
1 In the Properties dialog box, click the Output tab, and then click Job Settings. The Job 

Settings dialog box appears.

Printer Driver Menu 
Options

Function Job Deletion 
after Printing

Access 
Code

Panel Message
(Category)

Default number 
of pages printed

Quick Copy After printing a job, you 
can reprint it from the 
printer operator panel.

Saved until printer 
power is turned off

No Menu> e-MPS 
>Quick Copy

Same as for 
original job 
(adjustable)

Proof and Hold When you print multiple 
copies, the printer 
produces one copy for 
proofing and pauses. You 
can resume printing the 
remaining copies from the 
printer operator panel.

Saved until printer 
power is turned off 

No Menu> e-MPS 
>Quick Copy

One fewer than 
original job 
(adjustable)

Private Print Saves print jobs (without 
printing them) for printing 
later using the printer 
operator panel. Printing 
with this function requires 
an access code.

Deleted after 
printing

Yes Menu> e-MPS > 
Private/Stored

Same as for 
original job 
(adjustable)

Job Storage This function is used for 
saving frequently used 
office forms to print later 
as needed. You can print 
the required number of 
copies later from the 
printer operator panel.

Saved until 
manually deleted

Optional Menu> e-MPS > 
Private/Stored

1

NOTE

• Sometimes the application settings are given priority over the printer driver 
settings, causing a change in the output method.

• If you select one of the Job Settings options, the hard disk icon appears in the 
lower corner of the 3-D image.
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2 In the Job Settings dialog box, enable the Job Storage (e-MPS) check box. For Quick 
Copy printing, select Quick Copy.

3 You can name the job for later reference when printing from the print operator panel. In 
Job Name, select Application Defined for automatic naming by the application. Or, select 
Custom to enter a name of your choice. The name can be up to 31 characters.

4 Click OK.
5 When you print from the application, the job will be saved to the hard disk while the 

specified number of copies prints.
For further details on printing additional copies of a Quick Copy job, refer to Printing 
Additional Copies of Quick Copy Jobs on page 110.

Printing Additional Copies of Quick Copy Jobs

1 Press the MENU key on the printer operator panel.
2 Press the  or  key repeatedly until e-MPS > appears.
3 Press the  key to access the submenu. 
4 Press the  or  key repeatedly until >Quick Copy appears. 
5 Press the ENTER key. A blinking question mark [ ? ] displays by the user name.
6 If the user name is correct, press the ENTER key. Otherwise, press the  or  key until the 

correct name appears.
7 Press the ENTER key. Follow the instructions in the Identification on page 34 to continue.
8 The job name appears with a blinking question mark [ ? ].

If this is the correct job for printing, press the ENTER key.
9 Otherwise, press the  or  key until the correct name appears. Then, press the ENTER 

key.
10 Press the  or  key to specify the number of copies.
11 Press the ENTER key. The Quick Copy job initially printed is printed in the specified 

number of copies.

Deleting Quick Copy Jobs

1 Refer to steps 1 through 8 in Printing Additional Copies of Quick Copy Jobs on page 110. 
2 If this is the correct job for deletion, press the ENTER key.

NOTE

The actual key operation may differ depending on the model.
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3 Otherwise, press the  or  key until the correct name appears.
4 After the menu for specifying the number of print copies appears, press the  key once. 

Delete appears.
5 Press the ENTER key to delete the job.

Proof and Hold

1 Access the Job Settings dialog box as indicated in the instructions for Quick Copy on page 
109. Select Proof and Hold.

2 Name the job for future reference when printing from the print operator panel.
• If you select Application Defined in Job Name, the application automatically names 

the document.
• In the Job Name area, select Custom to enter a name of your choice. The name can be 

up to 31 characters in length.

3 Click OK. 
When printing a Proof and Hold job of multiple copies, only the first copy is printed and the 
remaining copies are saved. Follow the steps below after proofing the first copy.

Printing the 
Remaining 
Copies of Proof 
and Hold Jobs

You can print the remaining copies of Proof and Hold jobs following the same steps as for 
Printing Additional Copies of Quick Copy Jobs on page 110. Use the keys on the printer 
operator panel to proceed. When using the Proof and Hold option, the number of copies 
displayed will be one less than the total due to the existing proof copy. The printed jobs will 
remain saved on the hard disk until the printer is turned off. To delete jobs manually, use the 
same key operations as explained in Deleting Quick Copy Jobs on page 110.

Private Print Private Print jobs are saved to the hard disk for printing until a four-digit access code is 
entered.
The saved jobs are deleted as soon as they are printed. 

To print using Private Print, follow these steps:

1 Access the Job Settings dialog box as indicated in the instructions for Quick Copy on 
page 109. Select Private Print.

2 Enter four digits with any numbers between 0 and 9 for the Access Code. 
When you want to print a saved job, enter the access code on the printer operator panel.



112

3 You can name the job for later reference when printing from the print operator panel.
• If you select Application Defined in Job Name the application automatically names 

the document.
• In Job Name, select Custom to enter a name of your choice. The name can be up to 31 

characters in length.

4 Click OK.

Printing Private 
Print Jobs

1 On the printer operation panel, press the MENU key.
2 Press the  or  key repeatedly until e-MPS > appears.
3 Press the  key to access the submenu.
4 Press the  or  key repeatedly until >Private/Stored appears.
5 Press the ENTER key, the user name displays with a blinking question mark [ ? ].
6 If the user name is correct, press the ENTER key. Otherwise, press the  or  key until the 

correct name is displayed.
7 The job name is displayed with a blinking question mark [ ? ]. Press the ENTER key.
8 The user name displayed is specified following the instructions in the Identification on 

page 34. If this is the correct job for printing, press the ENTER key.
9 Otherwise, press the  or  key until the correct job name appears, then press the ENTER 

key.
10 Enter the four-digit access code created in Private Print on page 111. 
11 Press the  or  key to increase or decrease the number. 
12 Press the  or  key to move the cursor right and left.
13  Press the ENTER key. Use the  or  key to specify the number of copies for printing.
14 Press the ENTER key to start printing.
15 After printing, the job will be automatically deleted from the hard disk. To delete the job 

without printing it, follow the same procedure as in Deleting Quick Copy Jobs on page 110.

Job Storage The Job Storage feature saves jobs on the hard disk for future printing, even if the printer is 
switched off. You can also use access codes to restrict the printing of forms.

NOTE

The actual key operation may differ depending on the printer model.
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1 Access the Job Settings dialog box as indicated in the instructions for Quick Copy on page 
109. Select Job Storage.

2 Select the Access Code check box and enter the desired four-digit access code using 
numbers between 0 and 9. When you want to print the saved jobs, enter the access code on 
the print operator panel.

3 You can name the job for future reference when printing from the print operator panel.
• If you select Application Defined in the Job Name field, the application automatically 

names the document.
• In Job Name, select Custom to enter the name of your choice. The name can be up to 

31 characters in length.

4 Click OK. When you select print, the job will be saved to the hard disk without printing.

Printing Jobs 
Saved Using Job 
Storage

To print forms and other documents saved using Job Storage, follow the same steps as for 
Printing Private Print Jobs on page 112.
The stored jobs will remain saved even after the printer is switched off. To delete them 
manually, follow the same steps as for Deleting Quick Copy Jobs on page 110. When deleting 
jobs, you must enter the same access code as saved in the Job Storage procedure.

Virtual Mailbox
With the Virtual Mailbox feature, mailboxes created on the hard disk are assigned to multiple 
users. Jobs posted to a virtual mailbox can be printed later from the printer operator panel. Jobs 
saved in virtual mailboxes are automatically deleted after printing and jobs that have not been 
printed are saved if the printer is switched off. You must create and setup your virtual 
mailboxes prior to utilizing this feature.

NOTE

The Virtual Mailbox feature is available when the printer is set to emulate HP PCL 
5e, PCL XL, or PCL 5c. For information on emulation settings, refer to Page 
Description Language (PDL) Settings on page 36.
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Create a virtual mailbox by specifying a mailbox name and number. The figure below 
illustrates the virtual mailbox option. For further details, refer to Creating Virtual Mailboxes 
on page 114.

The following sections explain how to utilize the virtual mailbox option:
• Creating Virtual Mailboxes
• Importing and Exporting the Virtual Mailbox List
• Saving Jobs in Virtual Mailboxes
• Printing Virtual Mailbox Job Lists
• Printing Jobs in Virtual Mailboxes

Creating Virtual Mailboxes

1 Click Start in the Windows taskbar, and click Printers and Faxes to open the Printers and 
Faxes window.

2 Right-click the icon for your printer in the Printers and Faxes window. A list appears.

NOTE

• You can group multiple mailboxes and identify the group with a unique 
name. You can save jobs into multiple mailboxes, or save it into all the 
mailboxes at the same time. 

• Up to 255 mailboxes can be created. The total mailbox capacity varies 
depending on the printer model and the size of the hard disk installed. For 
example, an ECOSYS FS-1800 printer with a 1 GB microdrive offers an 
initial mailbox capacity of 50 MB. For further details on virtual mailbox 
capacities of each model, refer to the printer’s Operation Guide.

Resort development

Sales department

Use the printer driver to select a 
virtual mailbox for saving a job.

Examination department
Mailbox 1

Mailbox 2

Mailbox 3

Mailbox 4

Mailbox 5
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3 Click Properties in the list. The Properties dialog box appears. Click the Device Settings 
tab.

4 Select the Hard Disk check box. The Hard Disk Settings dialog box appears. 

5 Click New and enter any name into Mailbox Name.
For example, name the mailbox after the user or department. The name can be up to 31 
characters in length.

6 The mailbox names appear in the Defined Names list at right.

7 Enter a number between 1 and 255 for the Mailbox Number.
You can enter commas and hyphens to organize multiple mailboxes for the same user. In 
the following example, when the numbers 1, 3, 6, 8-12 are entered, mailboxes 1, 3, 6, 8, 9, 
10, 11, and 12 will be assigned to the name specified in Mailbox Name. Print jobs are 
saved in those boxes simultaneously. 

To assign multiple mailboxes, repeat the above steps. When finished, click OK to close the 
Hard Disk Settings dialog box.
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Importing and Exporting the Virtual Mailbox List

This section explains how to import and export your virtual mailbox lists. You can save the list 
of virtual mailboxes created in the previous section onto your personal computer. Once saved, 
the list can be read by other printer drivers. 
1 Follow the instructions in the previous section to display the Hard Disk Settings of the 

printer driver that will be the source of the list. Click Export....

2 The Export VMB List dialog box appears. Select save location from the Save in list. 
3 Enter a name in the File name field and click Save. Close the Properties dialog box.

NOTE

• It is also possible to assign mailboxes using the same mailbox numbers for 
users with different names. However, be aware that this will result in shared 
mailboxes.

• To delete a mailbox that you created, select the mailbox from the Defined 
Names list and click Delete.
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4 Click Import... to display the Hard Disk Settings of the printer driver that are the 
destination for the list.

5 The Import VMB List dialog box appears. Select the virtual mailbox data file you wish to 
read from the Look in list.

6 Click the virtual mailbox list name and click Open.

7 The virtual mailbox list is opened and displayed in the Defined Names area. Click OK to 
save the list. The imported list will replace all Defined Names that were already in the list.

Saving Jobs in Virtual Mailboxes

1 From the application’s Print dialog box, access the Properties. Select Print from the File 
menu and select Properties.

2 Open the Properties dialog box, and click the Output tab.
3 Click Job Settings... to open the Job Settings dialog box.
4 Select the Job Storage (e-MPS) check box.
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5 Select Virtual Mail Box VMB and click Selection... .

If Virtual Mail Box VMB is inactive, no virtual mailboxes have been created yet. Click 
Cancel in the screen above, and create a virtual mailbox while referring to RAM Disk 
Settings on page 33.

6 The Virtual Mailbox Selection dialog box appears. Select the mailboxes for saving the job, 
and click OK.

7 Close the Properties dialog box. The job is saved to the virtual mailbox on the hard disk 
and held for printing.
• Printing the list -- Refer to the next section, Printing Virtual Mailbox Job Lists, below. 
• Printing saved jobs -- Refer to Printing Jobs in Virtual Mailboxes on page 119.

Printing Virtual Mailbox Job Lists

Follow these steps to print the jobs lists of virtual mailboxes. You can print a list if there is at 
least one job saved in the virtual mailbox. 
The list is printed from the printer operator panel.
1 On the printer operator panel, press the MENU key.
2 Press the  or key repeatedly until e-MPS> is displayed.
3 Press the  key to access the submenu.
4 Press the  or  key repeatedly until >List of VMB appears. 

This menu is not displayed if all virtual mailboxes are empty.
5 Press the ENTER key. A blinking question mark [ ? ] appears.
6 Press the ENTER key again. The list will be printed.
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The job list information shows the number of saved jobs, number of pages, size, and other 
specific details for each virtual mailbox. The symbol  to the left of a virtual mailbox 
indicates jobs in the mailbox.

Printing Jobs in Virtual Mailboxes

1 On the printer operator panel, press the MENU key.
2 Press the  or  key repeatedly until e-MPS >appears.
3 Press the  key to access the submenu. 
4 Press the  or  key repeatedly until the display looks like the example shown below. 

This menu is not available if all virtual mailboxes are empty.

Tray 001: Represents Virtual Mailbox 1.
5 Press the ENTER key. A blinking question mark [ ? ] is displayed.

6 To print the jobs in those virtual mailboxes, press the ENTER key.
All jobs in the virtual mailboxes are printed. Once printed, the jobs are automatically deleted 
from the virtual mailboxes.

Temporary and Permanent Jobs
Functions for jobs saved as Temporary and Permanent jobs are similar to the functions for 
Quick Copy and other features described in Job Settings on page 108. However, these 
functions are provided for backward compatibility with printing environments developed 
before the Job Option. Similar to job options, temporary and permanent jobs use electronic 
sorting for faster printing of jobs with multiple copies. 

          Virtual Mailbox Job List

>Print VMB Data
Tray 001:

NOTE

At this point, if there are jobs in other virtual mailboxes, you can select them 
(Tray...) by pressing the  or  key.
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The features are listed below:
• Jobs are managed internally with job IDs and printed after saving by an application (KM-

NETJob Manager).
• Barcode Print Output is supported and facilitates future printing with an optional barcode 

reader. 
• Both types of jobs are saved on the hard disk, up to the user-defined capacity. However, 

temporary jobs are automatically deleted if the defined capacity is reached. Permanent jobs 
remain saved until removed by the user. 

Printing and Saving Temporary and Permanent Jobs

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu).

2 Open the Properties dialog box, and click the Output tab.
3 Click Job Settings... to access the Job Settings dialog box.
4 Select the Job Storage (e-MPS) check box. Select Temporary or Permanent.
5 When printing a job with a job ID barcode, open the Barcode Option dialog box and make 

the appropriate settings.

Click OK to return to the Print dialog box. While printing, the job will be simultaneously saved 
on the hard disk as either a temporary or permanent job.

NOTE

Check that your printer has an optional hard disk installed. 

NOTE

For further details, refer to Printing Additional Copies of Saved Jobs on page 122.

NOTE

To reprint temporary or permanent jobs, the dedicated KM-NET Job Manager 
utility is required. 
For further details, refer to Using KM-NET for Clients to Print Saved Jobs Again 
on page 121.
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Using KM-NET for Clients to Print Saved Jobs Again

To print out jobs, the KM-NET for Clients utility must first be installed on your computer. The 
utility is located on the supplied Kyocera Software Library CD-ROM. 

1 From the CD-ROM Main Menu dialog box, select Printer Utilities, then KM-NET for 
Clients to install the software.

After installation, follow these steps to launch the KM-NET Job Manager utility:
2 Click Start in the Windows taskbar and All Programs.

3 Click Add. Depending on your printer connections, select either the Local printer (for 
Parallel Connection) or Network printer.

Follow the wizard through the To reprint temporary or permanent jobs, the dedicated KM-NET 
Job Manager utility is required. 
4 Follow the wizard through the Starting Add Printing System Wizard dialog box. 

Available printers are displayed.

NOTE

The KM-NET for Clients communicates with the printer using TCP/IP protocol. To 
make a local connection with your computer, the KX printer driver must be 
installed on it. Local connection cannot be used in Windows 2000. 

NOTE

To reprint temporary or permanent jobs, the dedicated KM-NET Job Manager 
utility is required. 
 Click Programs, KYOCERA MITA, and then To reprint temporary or permanent 
jobs, the dedicated KM-NET Job Manager utility is required. 
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5 Select the printer to connect and click Finish to return to the main dialog box of the KM-
NET for Clients.

6 Select the printer icon displayed in the main dialog box and click Job Manager. Print jobs 
saved in the printer are displayed.

7 Right-click on the job name and select Print from the list to print a saved job. 
You can also select multiple jobs for printing simultaneously.
To select multiple jobs, click the jobs while holding down the Ctrl key. Saved jobs are 
stored on the hard disk. 

Printing 
Additional 
Copies of Saved 
Jobs

You can reprint saved print jobs using the optional barcode reader. Use the printer’s serial 
interface to connect the barcode reader to the printer.
When initially printing a job, follow the steps below to print a barcode representing the job ID 
on each page or on the cover page only.

NOTE

To delete jobs manually, right-click on the job name and select Delete from the list. 
For further details, refer to KM-NET for Clients Operation Guide.

{28L016T50}
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By simply reading the barcode with the barcode reader, you can reprint either a page or the 
entire job.

Printing a barcode on a print job

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu).

2 Open the Properties dialog box, and click the Output tab.
3 Click Job Settings... to access the Job Settings dialog box.
4 Select the Job Storage (e-MPS) check box. Select Temporary or Permanent.
5 Click Options... to open the Job Storage Options dialog box.

6 Select the Barcode check box. Select Print first page only or Print all pages.
7 If you want to print the job ID as characters with the barcode, as shown in the diagram 

below, enable the Print Barcode ID check box.

8 From the Position list, select the barcode position on the page. From the Orientation list, 
select the direction of the barcode.

9 Click OK.

{28L016T50}
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The combinations of barcode printing position and orientations are shown in the table below.

When printing, the barcode is printed in the designated position.

Reading with the 
Barcode Reader

When the printed job ID is read by the barcode reader, the printer outputs that page.
• If the barcode on the front cover is read, all pages are printed. 
• If pages are read individually, only the pages that are read are printed. 

Orientations Position
Upper-Right Lower-Right Upper-Left Lower-Right

Horizontal

Vertical

NOTE

This feature requires switching the serial interface mode to work with the barcode 
reader. For further details, refer to the barcode reader's Operation Guide.
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Saving Profiles
You can save print settings made on the Media, Output or other tabs in the Printer Propterties 
dialog box. By creating a profile out of the saved settings, they can be easily recalled, 
eliminating the need to reset them on the dialog box tabs. Profiles can be easily added, edited, 
or deleted. Profiles from other printers can also be read. 

Creating Profiles

Follow these steps to create a new profile. 

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu and select Properties.)

2 Configure the appropriate options on each setting tab. 
3 Click the Profile tab in the Properties dialog box.

Using the Barcode Reader to Read the Job Code

Barcode Reader

Job Code

NOTE

If a shared profile is installed when printer driver option settings are being set, its 
icon is displayed in the list on the Profile tab, and it can be shared by each printer. 
For further details, refer to Installing Components on page 25.
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4 Click Add to access the Add Profile dialog box.

5 Enter a Name for the Profile Information, and select the Icon Style. The name can be up to 
31 characters.

6 Select a color for the Profile Information from the Icon Color list. This option allows you 
to sort icons by color.

7 Enter comments about the settings into the Profile Information Description section. Up to 
256 characters can be entered for the comments. 

8 Click OK to save the profile. The display returns to the Profile tab. 
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9 The Profile Selections displays the icon and name, and the Profile Information displays 
the settings and comment. Click Use to activate the displayed printer settings. 

Editing Profiles

The Name, Icon Style, Icon Color, and Description of created and shared profiles can be edited. 

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu and select Properties.)

2 Click the Profile tab in the Properties dialog box.
3 Select the profile to be edited from the Profile Selections, and click Edit. 
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4 The Edit Profile dialog box appears. Edit the profile information's Name, Icon Style, Icon 
Color, and Description. For further details, refer to Creating Profiles on page 125.

5 Click OK to save the edited profile. 

Deleting Profiles

1 From the application’s Print dialog box, access the Properties. (Select Print from the File 
menu and select Properties.)

2 Click the Profile tab in the Properties dialog box. Select the profile to be deleted from the 
Profile Selections, and click Delete. 

3 Click OK. 

Importing and Exporting Profiles

You can save your profile on your personal computer and have it read by other printers. The 
profiles on several printers can be shared. Print results may vary depending on the printer 
model.
1 From the application’s Print menu, access the Properties. (Select Print from the File menu 

and select Properties.)
2 In the source printer driver, click the Profile tab in the Properties dialog box. 
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3 Select the profile to be read from the Profile Selections, and click Export... .

4 The Export Profile dialog box appears. Save the profile. 
5 Specify the save location in the Save in list, enter a name for the file in the File name field, 

and click Save. Close the Properties dialog box.

6 In the destination printer driver, click the Profile tab in the Properties dialog box. Click 
Import... .

Read source

Read source

Read Destination
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7 The Import Profile dialog box appears. Select the profile from the Look in list, select the 
profile name, and then click Open.

8 If a message dialog box appears displaying “Some profile settings are not applicable to 
this model. Do you want to continue?”, there are unusable functions in this profile. Click 
OK to return to the Profile tab.

9 The profile read by the printer driver displays in the Profile Selections, and profile reading 
is finished.

Read destination

Read destination
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Setting Information
You can confirm settings made on the Media, Layout, Imaging, Color, Output, Prologue/
Epilogue, Watermark, and Device Settings tabs. 
By simply clicking Setting Information... on the Printing Preferences/Properties dialog 
box, current driver settings can be displayed in a tree view.

NOTE

Displayed settings may vary depending on the PDL
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Appendix A  Available Fonts

MTI (AGFA) 80 FONTS 
 

Font Name File Name  Font Name File Name 
     

Albertus Extra Bold KYCW1_1.TTF ITC Avant Garde Gothic Book Oblique  KYCW1_48.TTF 
Albertus Medium KYCW1_0.TTF ITC Avant Garde Gothic Demi KYCW1_49.TTF 

Antique Olive KYCW1_2.TTF ITC Avant Garde Gothic Demi Oblique KYCW1_50.TTF 

Antique Olive Bold KYCW1_4.TTF ITC Bookman Demi KYCW1_53.TTF 

Antique Olive Italic KYCW1_3.TTF ITC Bookman Demi Italic KYCW1_54.TTF 
Arial KYCW1_5.TTF ITC Bookman Light KYCW1_51.TTF 
Arial Bold KYCW1_7.TTF ITC  Bookman Light Italic KYCW1_52.TTF 
Arial Italic KYCW1_6.TTF ITC Zapf Chancery Medium Italic KYCW1_79.TTF 
Arial Bold Italic KYCW1_8.TTF =DSI  ITC Zapf Dingbats  KYZAPF.TTF 
CG Times KYCW1_27.TTF Letter Gothic KYCW1_19.TTF 
CG Times Bold KYCW1_29.TTF Letter Gothic Bold KYCW1_21.TTF 
CG Times Italic KYCW1_28.TTF Letter Gothic Italic KYCW1_20.TTF 
CG Times Bold Italic KYCW1_30.TTF Marigold KYCW1_22.TTF 
CG Omega KYCW1_23.TTF New Century Schoolbook Roman KYCW1_67.TTF 
CG Omega Bold KYCW1_25.TTF New Century Schoolbook Bold KYCW1_69.TTF 
CG Omega Italic KYCW1_24.TTF New Century Schoolbook Italic KYCW1_68.TTF 
CG Omega Bold Italic KYCW1_26.TTF New Century Schoolbook Bold 

Italic 
KYCW1_70.TTF 

Clarendon Condensed Bold KYCW1_9.TTF Palatino KYCW1_71.TTF 
Coronet KYCW1_10.TTF Palatino Bold KYCW1_73.TTF 
Courier KYCW1_11.TTF Palatino Italic KYCW1_72.TTF 
Courier Bold KYCW1_13.TTF Palatino Bold Italic KYCW1_74.TTF 
Courier Italic KYCW1_12.TTF Σψμβολ  Symbol KYSYM.TTF 
Courier Bold Italic KYCW1_14.TTF   SymbolPS KYSYM1.TTF 
CourierPS KYCW1_55.TTF Times Roman KYCW1_75.TTF 
CourierPS Bold KYCW1_57.TTF Times Bold KYCW1_77.TTF 
CourierPS Oblique KYCW1_56.TTF Times Italic KYCW1_76.TTF 
CourierPS Bold Oblique KYCW1_58.TTF Times Bold Italic KYCW1_78.TTF 
Garamond Antiqua KYCW1_15.TTF Times New Roman KYCW1_31.TTF 
Garamond Halbfett KYCW1_17.TTF Times New Roman Bold KYCW1_33.TTF 
Garamond Kursiv KYCW1_16.TTF Times New Roman Italic KYCW1_32.TTF 
Garamond Halbfett Kursiv KYCW1_18.TTF Times New Roman Bold Italic KYCW1_34.TTF 
Helvetica KYCW1_59.TTF Univers Bold KYCW1_37.TTF 
Helvetica Bold KYCW1_61.TTF Univers Bold Condensed KYCW1_41.TTF 
Helvetica Oblique KYCW1_60.TTF Univers Bold Italic KYCW1_38.TTF 
Helvetica Bold Oblique KYCW1_62.TTF Univers Bold Condensed Italic KYCW1_42.TTF 
Helvetica Narrow KYCW1_63.TTF Univers Medium KYCW1_35.TTF 
Helvetica Narrow Bold KYCW1_65.TTF Univers Medium Condensed KYCW1_39.TTF 
Helvetica Narrow Oblique KYCW1_64.TTF Univers Medium Italic KYCW1_36.TTF 
Helvetica Narrow Bold Oblique KYCW1_66.TTF Univers Medium Condensed Italic KYCW1_40.TTF 
ITC Avant Garde Gothic Book KYCW1_49.TTF   Wingdings KYWD_29.TTF 
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A
Accessing Printer Properties  29
Adjusting Color  78
Administrator Password  39
Administrator Settings  38
Applications, printing from  47
Assigning Virtual Mailboxes  32
Auto Configuration  43

B
Barcode Reader

reading with  124
Basic Printing Tasks  47
Binding

Left-Edge and Right-Edge  103– 104
Booklet Printing  102– 103
Booklet Stitcher Punch Settings  32

C
Cassettes  56
Collate, rotate  108
Collating Modes  104
Color

adjusting  78
Adjustment Settings  83– 86
Adjustment Settings -- RGB  86– 88
Correction  80– 81
custom  68
HSL  83– 86
Ink Simulation  81
Matching  80
Mode  78– 79

Definitions  79– 80
Setting  80

Monitor Simulation  81
Reproduction  81– 83
RGB  86– 88
settings  78

Combinations
media  99– 100

Commands, embedding in document  63
Compatibility settings  41– 43
Components

installing  25
Cover

printing  94
printing options  94,  97
printing with  93

Cover Mode  93– 94
Custom Colors

selecting and creating  67– 68
Custom Paper Sizes  57

D
Data Passthrough  38
Device fonts

disabling  75
Device fonts, disabling  74
Document image, sizing  51
Document Portability  77
Downloading fonts  74
Duplex

manual  59
Duplex Printing  58– 59
Duplexer unit  56

E
EcoPrint  72– 73

F
Fast Printing  77
Finisher  31
Finisher Punch Settings  31
Firewall  44– 45
Fonts  38,  74

Downloading  74
Settings  75
Substitution  75

FS-1018  35

Index
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G
Grayscale Adjustment  73

H
Half Tone Screen Settings  78
Halftone Screen  77

I
ICM  81
ICM Settings  81
Identification  34
Image

Settings  71
Image Data Format Options  77
Image Refinement  73
Inserting a page  97– 98
Installation  1
Installing Components  25
Installing Optional Devices  30

J
Job Accounting  38
Job Name Display  39
Job Settings  109
Job Storage  109,  112– 113
Jobs

temporary and permanent  119– 120

K
KM-NET for Clients

using to print saved jobs  121
KPDL  36– 38,  52

settings  76– 77
Kyocera Image Refinement  73

L
Language Preference Selection  35
Left-Edge and Right-Edge Binding  103– 104
License Agreement  2
Local Connection  1
LPR Connection  1,  18

M
Macros  63
Mailbox

virtual  113– 119
Mailbox Mode  107
Mailboxes

assigning  32
Manual Duplex  59

Settings  60
Measurement  34
Media

combinations  99– 100
Media Type  37,  53– 54

available options  54
Mirror Print  77
monochrome printers  37
MP tray  56
Multiple Pages  51

N
Network Connection  1,  14
Non-Collating  106

O
Offset  91
Optional devices

installing  30
Options

for cover printing  94,  97

P
Page Description Language (PDL) Settings  36
Page Insert  93– 94,  97– 98
Page Size  51
Pages per Sheet  52
Paper Cassettes  54
Paper Size

matching  53
PCL  36

settings  76
PCL 5e  36– 37
PCL XL  37,  53
PDL  36– 37
PDL settings  30,  36
Preferences
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simplified interface  35
PRESCRIBE  63
Print and Hold

printing remaining copies  111
Print Borders  52
Print Quality  72
Print Size  51
Printer Driver

updating  27
Printer Properties

accessing  29
Printing

basic tasks  47
booklet  102
covers  94
duplex  58– 59
from Applications  47
Job ID using the barcode reader  123– 124
multiple pages  51
on Paper of Non-Standard Sizes  55
Remaining Copies of Proof and Hold Jobs  111
reverse order  62
Watermarks  64
with Custom Paper Sizes  57

Private Print  109,  111– 112
Profiles

creating  125– 126
deleting  128
editing  127– 128
importing and exporting  128
saving  125

Prologue/Epilogue  62
Proof and Hold  109,  111
Punch  92
Punch Settings  31
Punch Unit  31

Q
Quick Copy  109

additional copies  110
deleting  110

R
RAM Disk Settings  33
Reading with the Barcode Reader  124
recycled paper  50
Resolution  72– 73

Reverse Image  77
Reverse Order Printing  62
Rotate Collate  108
Rotated  50

S
Scaling  51– 52
Setting

staple  89
Settings

administrator  38
Administrator password  39
Booklet stitcher punch  32
Color

RGB  86– 88
color  78,  83– 86
color mode  80
color reproduction  82– 83
compatibility  41– 43
custom colors  67
Finisher punch  31
fonts  74
grayscale  73
half tone screen  78
HSL  83– 86
ICM  81
Image  71
Image Data Format  77
information  131
job  109
KPDL  76– 77
Mailbox, virtual  113– 119
manual duplex  60
PCL  76
PDL  30,  36
profiles  125– 126
Punch  31
RAM Disk  33
RGB  86– 88
stapler  89– 91
True Type  74
user  34
Watermarks  71

Simplified User Interface  35
Sorter Modes  104– 106
Staple  89
Stapler

settings  89– 91
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using  89– 91
Subsitution of fonts  75

T
Temporary and Permanent Jobs  119

printing  120
transparencies  50
Transparency Interleaving  93– 94,  100– 102
True Type Options  74
TrueType  38,  74

U
Unit of Measurement  34
USB Connection  1,  7
User Interface

simplified  35
User Settings  34

V
Virtual Mailbox  113– 119

assigning  32
printing job lists  118
printing jobs in  119
saving jobs  117

W
Watermarks

adding  65
deleting text  69
editing  70
Page Settings  71
positioning  68
printing  64
Properties  65– 66

X
XL  36





is a trademark of Kyocera Corporation 
©2005



Revision 1.3  2005.2


	Table of Contents
	Chapter 1 Installation
	Installing the Printer Driver in Windows
	Local Connection
	USB Connection
	Network Connection
	LPR Connection
	Installing Components
	Installing the Latest Printer Driver

	Chapter 2 Printer Properties
	Accessing Printer Properties
	Installing Optional Devices
	Punch Settings
	Booklet Stitcher Punch Settings
	Assigning Virtual Mailboxes
	RAM Disk Settings

	User Settings
	Identification
	Unit of Measurement
	Language Preference Selection
	Simplified User Interface

	Page Description Language (PDL) Settings
	Administrator Settings
	Job Accounting
	Job Name Display
	Setting the Administrator Password

	Compatibility Settings
	Auto Configuration

	Chapter 3 Printing from Applications
	Basic Printing Tasks
	Scaling

	Printing on Paper of Non-Standard Sizes
	Duplex Printing
	Manual Duplex

	Reverse Order Printing
	Prologue/Epilogue
	Printing Watermarks
	Adjusting Image Settings
	Print Quality
	Grayscale Adjustment
	Font Downloading

	Adjusting Color
	Color Mode


	Chapter 4 Using Optional Equipment
	Staple
	Using the Stapler

	Offset
	Punch
	Cover Mode, Page Insert, and Transparency Interleaving
	Printing with Covers
	Cover Printing Options
	Page Insert
	Combinations
	Transparency Interleaving

	Booklet Printing
	Left-Edge and Right-Edge Binding

	Collating Modes
	Sorter Modes
	Sorter Mode Differences
	Non-Collating
	Mailbox Mode

	Rotate Collate
	Job Settings
	Quick Copy
	Printing the Remaining Copies of Proof and Hold Jobs
	Private Print
	Printing Private Print Jobs
	Job Storage
	Printing Jobs Saved Using Job Storage

	Virtual Mailbox
	Temporary and Permanent Jobs
	Printing Additional Copies of Saved Jobs
	Reading with the Barcode Reader

	Saving Profiles
	Creating Profiles
	Editing Profiles

	Setting Information

	Appendix A Available Fonts
	Index



